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The Altera
®

JESD204B MegaCore
®

function is a high-speed point-to-point serial interface intellectual
property (IP).

The JESD204BMegaCore function is part of theMegaCore IP Library, which is distributedwith theQuartus
®

II software and downloadable from the Altera website at www.altera.com.

For system requirements and installation instructions, refer toAltera Software Installation&Licensing.Note:

Table 1-1: Brief Information About the JESD204B MegaCore Function

DescriptionItem

14.0Version

Release
Information

June 2014Release Date

IP-JESD204BOrdering Code

0116Product ID

6AF7Vendor ID

• Joint Electron Device Engineering Council (JEDEC)
JESD204B.01, 2012 standard release specification

• Device subclass:

• Subclass 0—Backwards compatible to JESD204A.
• Subclass 1—Uses SYSREF signal to support deterministic

latency. For converters with sample rates above 500 MS/sec.
• Subclass 2—Uses SYNC_Ndetection to support deterministic

latency. For converters with sample rates below 500 MS/sec.

Protocol FeaturesIP Core
Information

ISO
9001:2008
Registered
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Altera's standard warranty, but reserves the right to make changes to any products and services at any time without notice. Altera assumes
no responsibility or liability arising out of the application or use of any information, product, or service described herein except as expressly
agreed to in writing by Altera. Altera customers are advised to obtain the latest version of device specifications before relying on any published
information and before placing orders for products or services.
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DescriptionItem

• Run-time configuration of LMF
• Data rates up to 12.5 gigabits per second (Gbps)
• Single or multiple lanes (up to 8 lanes per link)
• Serial lane alignment and monitoring
• Lane synchronization
• Modular design that supports multidevice synchronization
• MAC and PHY partitioning
• Deterministic latency support
• 8B/10B encoding
• Scrambling/Descrambling
• Avalon

®
Streaming (Avalon-ST) interface for transmit and

receive datapaths
• Avalon

®
Memory-Mapped (Avalon-MM) interface for

Configuration and Status registers (CSR)
• Dynamic generation of simulation testbench

Core Features

IP Core
Information

• Wireless communication equipment
• Broadcast equipment
• Military equipment
• Medical equipment
• Test and measurement equipment

Typical Application

• Arria
®

V FPGA device families
• Arria V GZ FPGA device families
• Arria 10 FPGA device families
• Stratix

®
V FPGA device families

Refer to the device support table andWhat’s New in Altera IP page
of the Altera website for detailed information.

Device Family Support

• Qsys parameter editor in the Quartus
®

II software for design
creation and compilation

• TimeQuest timing analyzer in theQuartus II software for timing
analysis

• ModelSim
®
-Altera, Aldec Riviera-Pro, VCS/VCS MX, and

NCSim software for design simulation or synthesis

Design Tools

Related Information

• Altera Software Installation and Licensing

• What's New in Altera IP
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The Altera JESD204B IP core is a high-speed point-to-point serial interface for digital-to-analog (DAC) or
analog-to-digital (ADC) converters to transfer data to FPGA devices. This unidirectional serial interface
runs at amaximumdata rate of 12.5Gbps. This protocol offers higher bandwidth, low I/O count and supports
scalability in both number of lanes and data rates. The JESD204B IP core addresses multi-device synchro-
nization by introducing Subclass 1 and Subclass 2 to achieve deterministic latency.

The JESD204B IP core incorporates a media access control (MAC) and a physical layer (PHY).

• Media access control (MAC)—data link layer (DLL) block that controls the link states and character
replacement.

• Physical layer (PHY)—physical coding sublayer (PCS) and physical media attachment (PMA) block.

The JESD204B IP core does not incorporate the Transport Layer (TL) that controls the frame assembly and
deassembly. The TL and test components are provided as part of a design example component where you
can customize the design for different converter devices.
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Figure 2-1: Typical System Application for JESD204B IP Core

The JESD204B IP core utilizes the Avalon-ST source and sink interfaces, with unidirectional flow of data,
to transmit and receive data on the FPGA fabric interface.
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Key features of the JESD204B IP core:

• Data rate of up to 12.5 Gbps
• Run-time JESD204B parameter configuration (L, M, F, S, N, K, CS, CF)
• MAC and PHY partitioning for portability
• Subclass 0 mode for backward compatibility to JESD204A
• Subclass 1 mode for deterministic latency support (using SYSREF) between the ADC/DAC and logic

device
• Subclass 2 mode for deterministic latency support (using SYNC_N) between the ADC/DAC and logic

device
• Multi-device synchronization

Datapath Modes
The JESD204B IP core supports TX only, RX only, and Duplex (TX and RX) mode. The IP core is a
unidirectional protocol where interfacing to ADC utilizes the transceiver RX path and interfacing to DAC
utilizes the transceiver TX path.
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The JESD204B IP core generates a single link with a single lane and up to 8 lanes. If there are two ADC links
that need to be synchronized, you have to generate two JESD204B IP cores and thenmanage the deterministic
latency and synchronization signals like SYSREF and SYNC_N at your custom wrapper level.

The duplex mode is supported only if the LMF configuration for ADC (RX) is the same as DAC (TX) and
with the same data rate. This use case is mainly for prototyping with internal serial loopback mode. This is
because typically as a unidirectional protocol, the LMF configuration of converter devices for both DAC
and ADC are not identical.

IP Core Variation
The JESD204B IP core has three core variation—JESD204B MAC only, JESD204B PHY only, and JESD204B
MAC and PHY.

In a subsystem where there are multiple ADC and DAC converters, you need to use the Quartus II software
to merge the transceivers and group them into the transceiver architecture. For example, to create two
instances of the JESD204B TX IP core with four lanes each and four instances of JESD204 RX IP core with
two lanes each, you can apply one of the following options:

• MAC and PHY option

1. Generate JESD204B TX IP core with four lanes and JESD204B RX IP core with two lanes.
2. Instantiate the desired components.
3. Use the Quartus II software to merge the PHY lanes.

• MAC only and PHY only option—based on the configuration above, there are a total of eight lanes in
duplex mode.

1. Generate the JESD204B Duplex PHY with a total of eight lanes. (TX skew is reduced in this configu-
ration as the channels are bonded).

2. Generate the JESD204B TX MAC with four lanes and instantiate it two times.
3. Generate the JESD204B RX MAC with two lanes and instantiate it four times.
4. Create a wrapper to connect the JESD204B TX MAC and RX MAC with the JESD204B Duplex PHY.

If the data rate for TX and RX is different, the transceiver does not allow duplex mode to generate a
duplex PHY. In this case, you have to generate a RX-only PHY on the RX data rate and a TX-only
PHY on the TX data rate.

Note:

JESD204B IP Core Configuration

Table 2-1: JESD204B IP Core Configuration

ValueDescriptionSymbol

1-8Number of lanes per converter deviceL

1-32Number of converters per deviceM

1, 2, 4-256Number of octets per frameF

1-32Number of transmitted samples per converter per frameS
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ValueDescriptionSymbol

1-32Number of conversion bits per converterN

4-32Number of transmitted bits per sample (JESD204word size, which
is in nibble group)

N'

17/F ≤ K ≤ 32 ; 1-32Number of frames per multiframeK

0-3Number of control bits per conversion sampleCS

0-32Number of control words per frame clock period per linkCF

0 or 1High Density user data formatHD

(F × K /4) link clock counts
(1)

Local multiframe clockLMFC

Run-Time Configuration
The JESD204B IP core allows run-time configuration of LMF parameters.

The most critical parameters that must be set correctly during IP generation are the L and F parameters.
The hardware generates during parameterization, which means that run-time programmability can only
fallback from the parameterized and generated hardware but not beyond the parameterized IP core.

You can use run-time configuration for prototyping or evaluating the performance of converter devices with
various LMF configuration. However, in actual production, you are highly recommended to generate the
JESD204B IP core with the intended LMF to get an optimized gate count.

For example, if a converter device supports LMF = 442 and LMF = 222, to check the performance for both
configurations, you need to generate the JESD204B IP core with maximum F and L, which is L = 4 and F =
2. Parameter L denotes the maximum lanes supported while parameter F denotes the size of the deskew
buffer needed for deterministic latency. During operation, you can use the fallback configuration to disable
the lanes that are not used in LMF = 222 mode. You must ensure that other JESD204B configurations like
M, N, S, CS, CF, and HD do not violate the parameter F setting. You can modify other configurations like
K (multi-frame), device and lane IDs, enabling or disabling scrambler, and enabling or disabling character
replacement by accessing the Configuration and Status Register (CSR) space.

F Parameter

The F parameter indicates how many octets per frame per lane the JESD204B link is operating in. You must
set the F parameter according to the JESD204B IP Specification for a correct data mapping.

To design a core to support High Density (HD) data format, the JESD204B IP core tracks the start of frame
and end of frame since F can be either an odd or even number. The start of frame and start of multi-frame
wrap around the 32-bits data width architecture. The RX IP core outputs the start of frame (sof[3:0]) and
start of multiframe (somf[3:0]), which act as markers, using the Avalon-ST data stream. Based on these
markers, the transport layer build the frames.

In a simpler system where the HD data format is set to 0, the F will always be 1, 2, 4, 6, 8, and so forth. This
simplifies the transport layer design where you do not need to use the sof[3:0] and somf[3:0] markers.

(1) The value of F x K must be divisible by 4.
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Channel Bonding
The JESD204B IP core supports channel bonding—bonded and non-bonded modes.

The channel bonding mode that you select may contribute to the transmitter channel-to channel skew. A
bonded transmitter datapath clocking provides low channel-to-channel skew as compared to non-bonded
channel configurations.

Table 2-2: Maximum Number of Lanes (L) Supported in Bonded and Non-Bonded Mode

Maximum Number of
Lanes (L)

Bonding Mode ConfigurationCore VariationDevice Family

32 (2)Bonded
PHY only

Arria V
32 (2)Non-bonded

6Bonded
MAC and PHY

8Non-bonded

32 (2)Bonded
PHY onlyArria V GZ

Arria 10

Stratix V

32 (2)Non-bonded

8Bonded
MAC and PHY

8Non-bonded

• In PHY-only mode, you can generate up to 32 channels, provided that the channels are on the same side.
In MAC and PHY integrated mode, you can generate up to 8 channels.

• In bonded channel configuration, the lower transceiver clock skew and equal latency in the transmitter
phase compensation FIFO for all channels result in a lower channel-to-channel skew. You must use
adjacent channels when you select ×6 bonding. You must also place logical channel 0 in either physical
channel 1 or 4. Physical channels 1 and 4 are indirect drivers of the ×6 clock network. The JESD204B IP
core automatically selects between xN or fb_compensation bonding depending on the number of
transceiver channels you set.

• In non-bonded channel configuration, the transceiver clock skew is higher and latency is unequal in the
transmitter phase compensation FIFO for each channel. This may result in a higher channel-to-channel
skew.

(2) The maximum lanes listed here is for configuration simplicity. Refer to the Altera Transceiver PHY User Guide
for the actual number of channels supported.
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Performance and Resource Utilization

Table 2-3: JESD204B IP Core FPGA Performance

Link Clock FMAX (MHz)

Data Rate
FPGA Fabric Speed

Grade
PMA Speed GradeDevice Family Enable Soft PCS

(Gbps) (3)
Enable Hard PCS

(Gbps)

163.84— (4)6.55<Any supported
speed grade>

<Any supported
speed grade>

Arria V

247.50— (4)9.932
Arria V GZ

220.00— (4)8.843

312.50

12.512.21 or 21

Stratix V
12.512.21 or 2

2
12.59.83

8.58.52 or 3 or 43

The following table lists the resources and expected performance of the JESD204B IP core. These results are
obtained using the Quartus II software targeting the following Altera FPGA devices:

• Arria V : 5AGXFB3H4F35C5
• Arria V GZ : 5AGZME5K2F40C3
• Arria 10 : 10AX115H2F34I2SGES
• Stratix V : 5SGXEA7H3F35C3

All the variations for resource utilization are configured with the following parameter settings:

Table 2-4: Parameter Settings To Obtain the Resource Utilization Data

SettingParameter

Base and PHYJESD204B Wrapper

1JESD204B Subclass

5 GbpsData Rate

Enabled Hard PCSPCS Option

ATXPLL Type

Non-bondedBonding Mode

125.0 MHzReference Clock Frequency

1Octets per frame (F)

(3) Enable Soft PCS to achieve maximum data rate. For TX IP core, enabling soft PCS incurs an additional 3–8%
increase in resource utilization. For RX IP core, enabling soft PCS incurs an additional 10–20% increase in
resource utilization.

(4) Enabling Soft PCS does not increase the data rate for the device family and speed grade. You are recommended
to select the Enable Hard PCS option.
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SettingParameter

OffEnable Scrambler (SCR)

OffEnable Error Code Correction (ECC_EN)

Table 2-5: JESD204B IP Core Resource Utilization

The numbers of ALMs and logic registers in this table are rounded up to the nearest 100.

The resource utilization data are extracted from a full design which includes the Altera Transceiver PHY
Reset Controller IP Core. Thus, the actual resource utilization for the JESD204B IP core should be smaller
by about 15 ALMs and 20 registers.

Note:

Memory Block (M10K/
M20K) (5) (6)

Logic
Registers

ALUTsALMsNumber of
Lanes

Data PathDevice Family

11173149211251

RX

Arria V

21812232817862

43089405731064

85632771059778

0927113510131

TX
01039139713152

01262190919294

01710281430398

11192149811541

RX

Arria V GZ

21848235018312

43170410932224

85802784661828

0927113610161

TX
01059145113662

01323208420804

01852335734678

(5) M10K for Arria V device, M20K for Arria V GZ, Stratix V and Arria 10 devices.
(6) TheQuartus II softwaremay auto-fit to useMLABwhen thememory size is too small. Conversion fromMLAB

to M20K or M10K was performed for the numbers listed above.
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Memory Block (M10K/
M20K) (5) (6)

Logic
Registers

ALUTsALMsNumber of
Lanes

Data PathDevice Family

11172145210581

RX

Arria 10

21810225716532

43078392528854

85623742255158

091110798781

TX
01025133810872

01255186315014

01715292823058

11192149811481

RX

Stratix V

21852235018342

43163410932244

85789784661808

0928113610201

TX
01059145113672

01323208420774

01851335734718

Related Information

• JESD204B IP Core Parameters on page 3-10

• Fitter Resources Reports in the Quartus II Help
Information about the Quartus II resource utilization reporting, including ALMs needed.

(5) M10K for Arria V device, M20K for Arria V GZ, Stratix V and Arria 10 devices.
(6) TheQuartus II softwaremay auto-fit to useMLABwhen thememory size is too small. Conversion fromMLAB

to M20K or M10K was performed for the numbers listed above.
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The JESD204B IP core is part of the MegaCore IP Library, which is distributed with the Quartus II software
and downloadable from the Altera website at www.altera.com.

Related Information
Altera Software Installation & Licensing

Introduction to Altera IP Cores
Altera® and strategic IP partners offer a broad portfolio of off-the-shelf, configurable IP cores optimized for
Altera devices. Altera delivers an IP core library with the Quartus® II software. OpenCore Plus IP evaluation
enables fast acquisition, evaluation, and hardware testing of all Altera IP cores.

Nearly all complex FPGA designs include optimized logic from IP cores. You can integrate optimized and
verified IP cores into your design to shorten design cycles and maximize performance. The Quartus II
software includes the Altera IP Library, and supports IP cores from other sources. You can define and
generate a custom IP variation to represent complex design logic in your project.

The Altera IP Library includes the following IP core types:

• Basic functions
• DSP functions
• Interface protocols
• Memory interfaces and controllers
• Processors and peripherals

Related Information
IP User Guide Documentation

Installing and Licensing IP Cores
The Quartus II software includes the Altera IP Library. The library provides many useful IP core functions
for production use without additional license. You can fully evaluate any licensedAltera IP core in simulation
and in hardware until you are satisfied with its functionality and performance. Some Altera IP cores, such
as MegaCore® functions, require that you purchase a separate license for production use. After you purchase
a license, visit the Self Service Licensing Center to obtain a license number for any Altera product.
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9001:2008
Registered

© 2014 Altera Corporation. All rights reserved. ALTERA, ARRIA, CYCLONE, ENPIRION, MAX, MEGACORE, NIOS, QUARTUS and STRATIX words
and logos are trademarks of Altera Corporation and registered in the U.S. Patent and Trademark Office and in other countries. All other
words and logos identified as trademarks or service marks are the property of their respective holders as described at
www.altera.com/common/legal.html. Altera warrants performance of its semiconductor products to current specifications in accordance with
Altera's standard warranty, but reserves the right to make changes to any products and services at any time without notice. Altera assumes
no responsibility or liability arising out of the application or use of any information, product, or service described herein except as expressly
agreed to in writing by Altera. Altera customers are advised to obtain the latest version of device specifications before relying on any published
information and before placing orders for products or services.

www.altera.com

101 Innovation Drive, San Jose, CA 95134

https://www.altera.com/servlets/subscriptions/alert?id=UG-01142
mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20(UG-01142%202014.06.30)%20Getting%20Started&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.
http://www.altera.com/literature/manual/quartus_install.pdf
http://www.altera.com/literature/lit-ip.jsp
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html


Figure 3-1: IP Core Installation Path

acds
quartus - Contains the Quartus II software
ip - Contains the Altera IP Library and third-party IP cores

altera - Contains the Altera IP Library source code
<IP core name> - Contains the IP core source files

The default IP installation directory on Windows is <drive>:\altera\<version number>; on Linux it
is <home directory>/altera/ <version number>.

Note:

Related Information

• Altera Licensing Site

• Altera Software Installation and Licensing Manual

Upgrading Outdated IP Cores
Each IP core has a release version number that corresponds to its Quartus II software release. When you
include IP cores from a previous version of the Quartus II software in your project, click Project > Upgrade
IP Components to identify and upgrade any outdated IP cores.

TheQuartus II software prompts you to upgrade an IP core when the latest version includes port, parameter,
or feature changes. The Quartus II software also notifies you when IP cores are unsupported or cannot
upgrade in the current version of the Quartus II software. Most Altera IP cores support automatic simulta-
neous upgrade, as indicated in the Upgrade IP Components dialog box. IP cores unsupported by auto-
upgrade may require regeneration in the parameter editor, as indicated in the Upgrade IP Components
dialog box.

Before you begin

Upgrading IP cores changes your original design files. If you have not already preserved your original source
files, click Project > Archive Project and save the project archive.

1. In the latest version of the Quartus II software, open the Quartus II project containing an outdated IP
core variation.

File paths in a restored project archive must be relative to the project directory and you must
reference the IP variation .v or .vhd file or .qsys file, not the .qip file.

Note:

2. ClickProject >Upgrade IPComponents. TheUpgrade IPComponents dialog box displays all outdated
IP cores in your project, along with basic instructions for upgrading each core.

3. To simultaneously upgrade all IP cores that support automatic upgrade, click Perform Automatic
Upgrade. The IP variation upgrades to the latest version.

4. To upgrade IP cores unsupported by automatic upgrade, follow these steps:
a. Select the IP core in the Upgrade IP Components dialog box.
b. Click Upgrade in Editor. The parameter editor appears.
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c. ClickFinish orGenerate to regenerate the IP variation and complete the upgrade. The version number
updates when complete.

Example designs provided with any Altera IP core regenerate automatically whenever you
upgrade the IP core in the Upgrade IP Components dialog box.

Note:

Figure 3-2: Upgrading Outdated IP Cores

Displays upgrade
status for all IP cores
in the Project

Upgrades all IP core that support “Auto Upgrade”
Upgrades individual IP cores unsupported by “Auto Upgrade”

Indicates IP upgrade is:
Required
Optional
Complete
Unsupported

Example 3-1: Upgrading IP Cores at the Command Line

Alternatively, you can upgrade IP cores at the command line. To upgrade a single IP core, type the
following command:

quartus_sh --ip_upgrade -variation_files <my_ip_path> <project>

To upgrade a list of IP cores, type the following command:

quartus_sh --ip_upgrade -variation_files
 "<my_ip>.qsys;<my_ip>.<hdl>; <project>"

IP cores older than Quartus II software version 12.0 do not support upgrade. Altera
verifies that the current version of the Quartus II software compiles the previous

Note:

version of each IP core. The MegaCore IP Library Release Notes reports any
verification exceptions forMegaCore IP. TheQuartus II Software andDevice Support
Release Notes reports any verification exceptions for other IP cores. Altera does not
verify compilation for IP cores older than the previous two releases.

Related Information

• MegaCore IP Library Release Notes

• Quartus II Software and Device Support Release Notes
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IP Catalog and Parameter Editor
TheQuartus II IP Catalog (Tools > IPCatalog) and parameter editor help you easily customize and integrate
IP cores into your project. You can use the IP Catalog and parameter editor to select, customize, and generate
files representing your custom IP variation.

The IP Catalog automatically displays the IP cores available for your target device. Double-click any IP core
name to launch the parameter editor and generate files representing your IP variation. The parameter editor
prompts you to specify your IP variation name, optional ports, architecture features, and output file generation
options. The parameter editor generates a top-level .qsys or .qip file representing the IP core in your project.
Alternatively, you can define an IP variation without an open Quartus II project. When no project is open,
select the Device Family directly in IP Catalog to filter IP cores by device.

The IP Catalog is also available in Qsys (View > IP Catalog). The Qsys IP Catalog includes exclusive
system interconnect, video and image processing, and other system-level IP that are not available in
the Quartus II IP Catalog.

Note:

Use the following features to help you quickly locate and select an IP core:

• Filter IP Catalog to Show IP for active device family or Show IP for all device families.
• Search to locate any full or partial IP core name in IP Catalog. Click Search for Partner IP, to access

partner IP information on the Altera website.
• Right-click an IP core name in IPCatalog to display details about supported devices, installation location,

and links to documentation.

Figure 3-3: Quartus II IP Catalog

Search and filter IP for your target device

Double-click to customize, right-click for information
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The IP Catalog and parameter editor replace the MegaWizard
™

Plug-In Manager in the Quartus II
software. The Quartus II software may generate messages that refer to the MegaWizard Plug-In

Note:

Manager. Substitute "IP Catalog and parameter editor" for "MegaWizard Plug-In Manager" in these
messages.

Using the Parameter Editor
The parameter editor helps you to configure your IP variation ports, parameters, architecture features, and
output file generation options.

• Use preset settings in the parameter editor (where provided) to instantly apply preset parameter values
for specific applications.

• View port and parameter descriptions, and links to documentation.
• Generate testbench systems or example designs (where provided).

Figure 3-4: IP Parameter Editors

View IP port
and parameter
details

Apply preset parameters for
specific applications

Specify your IP variation name
and target device

Legacy parameter
editors

Design Walkthrough
This walkthrough explains how to create a JESD204B IP core design using Qsys in the Quartus II software.
After you generate a custom variation of the JESD204B IP core, you can incorporate it into your overall
project.

This walkthrough includes the following steps:

1. Creating a New Quartus II Project on page 3-6
2. Parameterizing and Generating the IP Core on page 3-6
3. Generating and Simulating the IP Core Testbench on page 3-7
4. Compiling the JESD204B IP Core Design on page 3-9
5. Programming an FPGA Device on page 3-9
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Creating a New Quartus II Project
You need to create a new Quartus II project with the New Project Wizard, which specifies the working
directory for the project, assigns the project name, and designates the name of the top-level design entity.

To create a new project, follow these steps:

1. From the Windows Start menu, select Programs >Altera >Quartus II <version> to launch the Quartus
II software. Alternatively, you can use the Quartus II Web Edition software.

2. On the File menu, click New Project Wizard.
3. In the New Project Wizard: Directory, Name, Top-Level Entity page, specify the working directory,

project name, and top-level design entity name. Click Next.
4. In the New Project Wizard: Add Files page, select the existing design files (if any) you want to include

in the project.(7) Click Next.
5. In the New Project Wizard: Family & Device Settings page, select the device family and specific device

you want to target for compilation. Click Next.
6. In the EDA Tool Settings page, select the EDA tools you want to use with the Quartus II software to

develop your project.
7. The last page in the New Project Wizard window shows the summary of your chosen settings. Click

Finish to complete the Quartus II project creation.

Parameterizing and Generating the IP Core

Before you begin

Refer to Table 3-3 for the IP core parameter values and description.

To parameterize the IP core, follow these steps:

1. In the IP Catalog (Tools > IP Catalog), locate and double-click the name of the IP core to customize.
The parameter editor appears.

2. Specify a top-level name for your custom IP variation. This name identifies the IP core variation files in
your project. If prompted, also specify the target Altera device family and output file HDL preference.
Click OK.

3. In the Main tab, select the the following options:

• Jesd204b wrapper
• Data path
• Jesd204b subclass
• Data Rate
• PCS Option
• PLL Type
• Bonding Mode
• PLL/CDR Reference Clock Frequency
• Enable PLL/CDR Dynamic Reconfiguration

(7) To include existing files, you must specify the directory path to where you installed the JESD204B IP core. You
must also add the user libraries if you installed the MegaCore IP Library in a different directory from where
you installed the Quartus II software.
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• Enable Bit reversal and Byte reversal

4. In the Jesd204b Configurations tab, select the following configurations:

• Common configurations (L, M, F, N, N', S, K)
• Advanced configurations (SCR, CS, CF, HD, ECC_EN, PHADJ, ADJCNT, ADJDIR)

5. In the Configurations and Status Registers tab, set the the following configurations:

• Device ID
• Bank ID
• Lane ID
• Lane checksum

6. After parameterizing the core, click Generate Example Design to create the simulation testbench. Skip
to step 8 if you do not want to generate the design example.

7. Set a name for your <example_design_directory> and click OK to generate supporting files and scripts.
The testbench and scripts are located in the <example_design_directory>/ip_sim folder.

The Generate Example Design option generates supporting files for the following entities:

• IP core for simulation—refer to Generating and Simulating the IP Core Testbench on page 3-7
• IP core design example for simulation—refer to Generating and Simulating theDesign Example on

page 5-52
• IP core design example for synthesis—refer to Compiling the JESD204B IP Core Design Example

on page 5-53

8. Click Finish or Generate HDL to generate synthesis and other optional files matching your IP variation
specifications. The parameter editor generates the top-level .qip or .qsys IP variation file and HDL files
for synthesis and simulation.

The top-level IP variation is added to the current Quartus II project. Click Project > Add/Remove Files
in Project to manually add a .qip or .qsys file to a project. Make appropriate pin assignments to connect
ports.

Some parameter options are grayed out if it is not supported in a selected configuration or it is a
derived parameter.

Note:

Generating and Simulating the IP Core Testbench
You can simulate your JESD204B IP core variation by using the provided IP core demonstration testbench.

To use the JESD204B IP core testbench, follow these steps:

1. Generate the simulation model. Refer to Generating the Testbench Simulation Model on page 3-8.
2. Simulate the testbench using the simulator-specific scripts that you have generated. Refer to Simulating

the IP Core Testbench on page 3-8.

Some configurations are preset and are not programmable in the JESD204B IP core testbench. For
more details, refer to JESD204B IP Core Testbench on page 3-14 or the README.txt file located in
the <example_design_directory>/ip_sim folder.

Note:
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Generating the Testbench Simulation Model

To generate the testbench simulation model, execute the generated script (gen_sim_verilog.tcl or
gen_sim_vhdl.tcl) located in the <example_design_directory>/ip_sim folder.

To run the Tcl script using the Quartus II sofware, follow these steps:

1. Launch the Quartus II software.
2. On the View menu, click Utilities and select Tcl console.
3. In the Tcl console, type cd <example_design_directory>/ip_sim to go to the specified

directory.
4. Type source gen_sim_verilog.tcl (Verilog) or source gen_sim_vhdl.tcl (VHDL) to

generate the simulation files.

To run the Tcl script using the command line, follow these steps:

1. Obtain the Quartus II software resource.
2. Type cd <example_design_directory>/ip_sim to go to the specified directory.
3. Type quartus_sh -t gen_sim_verilog.tcl (Verilog) or quartus_sh -t

gen_sim_vhdl.tcl (VHDL) to generate the simulation files.

Simulating the IP Core Testbench

The JESD204B IP core simulation supports ModelSim-Altera SE/AE, VCS, VCS MX, Cadence, and Aldec
Riviera simulators. The simulation setup scripts and run scripts are listed below.

VHDL is not supported in ModelSim-Altera AE and VCS simulators.Note:

Table 3-1: Simulation Setup Scripts

ScriptFile DirectorySimulator

msim_setup.tcl<example_design_directory>/ip_sim/testbench/setup_scripts/
mentor

ModelSim
®
-Altera

SE/AE

vcs_setup.sh<example_design_directory>/ip_sim/testbench/setup_scripts/
synopsys/vcs

VCS

vcsmx_setup.sh

synopsys_sim.setup

<example_design_directory>/ip_sim/testbench/setup_scripts/
synopsys/vcsmx

VCS MX

rivierapro_setup.tcl<example_design_directory>/ip_sim/testbench/setup_scripts/
aldec

Aldec Riviera

ncsim_setup.sh<example_design_directory>/ip_sim/testbench/setup_scripts/
cadence

Cadence

Table 3-2: Simulation Run Scripts

ScriptFile DirectorySimulator

run_altera_jesd204_tb.tcl<example_design_directory>/ip_sim/testbench/mentorModelSim-Altera
SE/AE
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ScriptFile DirectorySimulator

run_altera_jesd204_tb.sh<example_design_directory>/ip_sim/testbench/synopsys/vcsVCS

run_altera_jesd204_tb.sh<example_design_directory>/ip_sim/testbench/synopsys/
vcsmx

VCS MX

run_altera_jesd204_tb.tcl<example_design_directory>/ip_sim/testbench/aldecAldec Riviera

run_altera_jesd204_tb.sh<example_design_directory>/ip_sim/testbench/cadenceCadence

To simulate the testbench design using the ModelSim-Altera or Aldec Riviera-PRO simulator, follow these
steps:

1. Launch the ModelSim-Altera or Aldec Riviera-PRO simulator.
2. On the File menu, click Change Directory > Select

<example_design_directory>/ip_sim/testbench/<simulator name>.
3. On the File menu, click Load >Macro file. Select run_altera_jes204_tb.tcl. This file compiles the design

and runs the simulation automatically, providing a pass/fail indication on completion.

To simulate the testbench design using the VCS, VCS MX (in Linux), or Cadence simulator, follow these
steps:

1. Launch the VCS, VCS MX, or Cadence simulator.
2. On the File menu, click Change Directory > Select

<example_design_directory>/ip_sim/testbench/<simulator name>.
3. Run the run_altera_jes204_tb.sh file. This file compiles the design and runs the simulation automatically,

providing a pass/fail indication on completion.

Related Information
Simulating Altera Designs
More information about Altera simulation models.

Compiling the JESD204B IP Core Design

Before you begin

Refer to the design considerations section before compiling the JESD204B IP core design.

To compile your design, click Start Compilation on the Processing menu in the Quartus II software. You
can use the generated .qip file to include relevant files into your project.

Related Information

• JESD204B IP Core Design Considerations on page 3-10

• Quartus II Help
More information about compilation in Quartus II software.

Programming an FPGA Device
After successfully compiling your design, program the targetedAltera devicewith theQuartus II Programmer
and verify the design in hardware. For instructions on programming the FPGA device, refer to the Device
Programming section in volume 3 of the Quartus II Handbook.
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Related Information
Device Programming

JESD204B IP Core Design Considerations
You must be aware of the following conditions when integrating the JESD204B IP core in your design.

Pin Assignments
Set the pin assignments before you compile to provide direction to the Quartus II software Fitter tool. You
must also specify the signals that should be assigned to device I/O pins.

If you want to perform compilation but are not ready to map the design to hardware, you can create virtual
pins to avoid making specific pin assignments for top-level signals. You are recommended to create virtual
pins for all unused top-level signals to improve timing closure.

Do not create virtual pins for the clock or reset signals.Note:

Adding External Transceiver PLL
The JESD204B IP core variations that target an Arria 10 FPGA device require external transceiver PLLs for
compilation.

JESD204B IP core variations that target a V series FPGA device contain transceiver PLLs. Therefore, no
external PLLs are required for compilation.

You are recommend to use an ATX PLL or CMU PLL to get a better jitter performance.Note:

Related Information
Arria 10 Transceiver PHY User Guide
More information about the Arria 10 transceiver PLLs and clock network.

JESD204B IP Core Parameters

Table 3-3: JESD204B IP Core Parameters

DescriptionValueParameter

Main Tab

Select the targeted device family.• Arria V
• Arria V GZ
• Arria 10
• Stratix V

Device Family

Select to generate base only (MAC), PHY only (PCS and
PMA), or both base and PHY layers integrated (MAC and
PHY). The base only option is not supported for Duplex
mode.

• Base Only
• PHY Only
• Both Base and

PHY

JESD204B Wrapper
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DescriptionValueParameter

Select the operationmodes. This selection enables or disables
the receiver and transmitter supporting logic.

• RX—instantiates the receiver to interface to the ADC
• TX—instantiates the transmitter to interface to theDAC
• Duplex—instantiates the receiver and transmitter to

interface to both the ADC and DAC

• Receiver
• Transmitter
• Duplex

Data Path

Select the subclass modes.

• 0—Set subclass 0
• 1—Set subclass 1
• 2—Set subclass 2

• 0
• 1
• 2

JESD204B Subclass

Set the data rate for each lane. (8)

• Arria V—1.0 Gbps to 6.55 Gbps
• Arria V GZ—2.0 Gbps to 9.9 Gbps
• Arria 10—2.0 Gbps to 12.5 Gbps
• Stratix V—2.0 Gbps to 12.5 Gbps

1.0–12.5Data Rate

Select the PCS modes.• Enabled Hard
PCS

PCS Option

• EnabledHardPCS—utilizeHardPCS components. Select
this option to minimize resource utilization with data
rate that supports up to the Hard PCS's limitation.

For this setting, you will use 8G PCS mode
with 20 bits PMA width and 32 bits PCS
width.

Note:

• Enabled Soft
PCS

• Enabled Soft PCS—utilize Soft PCS components. Select
this option to allow higher supported data rate but
increase in resource utilization.

For this setting, you will use 10G PCS mode
with 40 bits PMA width and 40 bits PCS
width.

Note:

Select the Phase-Locked Loop (PLL) types.

Arria V device family only supports CMU PLL.

• CMU
• ATX

PLL Type

(8) The maximum data rate is limited by different device speed grade, transceiver PMA speed grade, and PCS
options. Refer to the JESD204B IP core FPGA Performance table in chapter 2 for the maximum data rate
support.
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DescriptionValueParameter

Select the bonding modes.

• Bonded—select this option tominimize inter-lanes skew
for the transmitter datapath.

• Non-bonded—select this option to disable inter-lanes
skew control for the transmitter datapath.

The bonding type is automatically selected based
on the device family and number of lanes that
you set.

Note:

• Bonded
• Non-bonded

Bonding Mode

Set the transceiver reference clock frequency for PLL or
CDR.

50.0–625.0PLL/CDR Reference Clock
Frequency

Turn on this option to enable dynamic data rate change.
When you enable this option, you need to connect the
reconfiguration interface to the transceiver reconfiguration
controller. (9)

On, OffEnable PLL/CDR Dynamic
Reconfiguration

Turn on this option to set the data transmission order in
MSB-first serialization. If this option is off, the data
transmission order is in LSB-first serialization.

On, OffEnable Bit reversal andByte
reversal

JESD204B Configurations Tab

Set the number of lanes per converter device. (10)1–8Lanes per converter device
(L)

Set the number of converters per converter device.1–32Converters per device (M)

The number of octets per frame derived from the formula
of F= M*N'*S/(8*L).

1, 2, 4–256Octets per frame (F)

Set the number of conversion bits per converter.1–32Converter resolution (N)

Set the number of transmitted bits per sample (JESD204B
word size). This value must be larger than the N value.

4–32Transmitted bits per sample
(N')

Set the number of transmitted samples per converter per
frame.

1–32Samples per converter per
frame (S)

Set the number of frames per multiframe. This value is
dependent on the value of F and is derived using the
following constraints:

• The value of K must fall within the range of 17/F <= K
<= min(32, floor (1024/F))

• The value of F*K must be divisible by 4

1–32Frames per multiframe (K)

(9) To perform dynamic reconfiguration, you have to instantiate the Transceiver Reconfiguration Controller
from the IPCatalog and connect it to the JESD204B IP core through the reconfig_to_xcvr and reconfig_
from_xcvr interface.

(10) Refer to the JESD204B IP core Resource Utilization table in chapter 2 for the supported range for L.
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Turn on this option to scramble the transmitted data or
descramble the receiving data.

On, OffEnable scramble (SCR)

Set the number of control bits per conversion sample.0–3Control Bits (CS)

Set the number of control words per frame clock period per
link.

0–32Control Words (CF)

Turn on this option to set the data format. This parameter
controls whether a sample may be divided over more lanes.

• On: High Density format
• Off: Data should not cross the lane boundary

On, OffHigh density user data
format (HD)

Turn on this option to enable error code correction (ECC)
for memory blocks.

On, OffEnable Error Code
Correction (ECC_EN)

Turn on this option to specify the phase adjustment request
to the DAC.

• On: Request for phase adjustment
• Off: No phase adjustment

This parameter is valid for Subclass 2 mode only

On, OffPhase adjustment request
(PHADJ)

Set the adjustment resolution for the DAC LMFC.

This parameter is valid for Subclass 2 mode only

0–15Adjustment resolution step
count (ADJCNT)

Select to adjust the DAC LMFC direction.

This parameter is valid for Subclass 2 mode only

• Advance
• Delay

Direction of adjustment
(ADJDIR)

Configurations and Status Registers Tab

Set the device ID number.0–255Device ID

Set the device bank ID number.0–15Bank ID

Set the lane ID number.0–31Lane# ID

Set the checksum for each lane ID.0–255Lane# checksum

Related Information
Performance and Resource Utilization on page 2-6

JESD204B IP Core Component Files
The following table describes the generated files and other files that may be in your project directory. The
names and types of generated files specified may vary depending on whether you create your design with
VHDL or Verilog HDL.
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Table 3-4: Generated Files

DescriptionExtension

IP core variation file, which defines a VHDL or Verilog HDL description of
the custom IP core. Instantiate the entity defined by this file inside of your
design. Include this file when compiling your design in theQuartus II software.

<variation name>.v or .vhd

AVHDL component declaration file for the IP core variation. Add the contents
of this file to any VHDL architecture that instantiates the IP core.

<variation name>.cmp

Contains timing constraints for your IP core variation.<variation name>.sdc

Contains Quartus II project information for your IP core variation.<variation name>.qip

Tcl script file to run in Quartus II software.<variation name>.tcl

Contains IP core library mapping information required by the Quartus II
software.The Quartus II software generates a . sip file during generation of
some Altera IP cores. You must add any generated .sip file to your project for
use by NativeLink simulation and the Quartus II Archiver.

<variation name>.sip

Contains a list of required simulation files for your IP core.<variation name>.spd

JESD204B IP Core Testbench
The JESD204B IP core includes a testbench to demonstrate a normal link-up sequence for the JESD204B IP
core with a supported configuration. The testbench also provides an example of how to control the JESD204B
IP core interfaces.

The testbench instantiates the JESD204B IP core in duplex mode and connects with the Altera Transceiver
PHY Reset Controller IP core. Some configurations are preset and are not programmable in the JESD204B
IP core testbench. For example, the JESD204B IP core always instantiates in duplex mode even if RX or TX
mode is selected in the JESD204B parameter editor.

Dynamic reconfiguration is not supported in this JESD204B IP core testbench.Note:

Table 3-5: Preset Configurations for JESD204B IP Core Testbench

Preset ValueConfiguration

Base and PHY (MAC and PHY)JESD204B Wrapper

DuplexData Path

• data_rate/20 (if you turn on Enabled Hard PCS)
• data_rate/40 (if you turn on Enabled Soft PCS)

PLL/CDR Reference Clock Frequency

Data rate/40Link Clock

125 MHzAVS Clock
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Figure 3-5: JESD204B IP Core Testbench Block Diagram

The external ATX PLL is present only in JESD204B IP core testbench targeting an Arria 10 FPGA device
family.

Reference Clock
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Packet
Generator
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JESD204B
IP Core
(Duplex)

Loopback

JESD204B Testbench

Related Information
Generating and Simulating the IP Core Testbench on page 3-7

Testbench Simulation Flow
The JESD204B testbench simulation flow:

1. At the start, the system is under reset, where all the components are in reset except for the JESD204B IP
core.

2. After 100 ns, the Transceiver Reset Controller IP core and CSR begin to power up. When both the
tx_ready and rx_ready signals from the transceiver reset controller are asserted, the JESD204B link
resets for 100 ns before testing the JESD204B IP core.

3. Once the link is out of reset, a SYSREF pulse is generated to reset the LMFC counter inside the JESD204B
IP core.

4. When the txlink_ready signal is asserted, the packet generator starts sending packets to the TXdatapath.
5. The packet checker starts comparing the packet sent from the TXdatapath and received at the RXdatapath

after the rxlink_valid signal is asserted.
6. The testbench reports a pass or fail when all the packets are received and compared.

The testbench concludes by checking that all the packets have been received.

If no error is detected, the testbench issues a TESTBENCH PASSEDmessage stating that the simulation
was successful. If an error is detected, aTESTBENCH FAILEDmessage is issued to indicate that the testbench
has failed.

Altera CorporationGetting Started

Send Feedback

3-15Testbench Simulation Flow
UG-01142
2014.06.30

mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Getting%20Started%20(UG-01142%202014.06.30)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


4JESD204B IP Core Functional Description
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The JESD204B IP core implements a transmitter (TX) and receiver (RX) block. Each block is divided into
two layers and consists of the following components:

• Media access control (MAC)—DLL block that consists of the link layer (link state machine and character
replacement), CSR, Subclass 1 and 2 deterministic latency, scrambler or descrambler, and multiframe
counter.

• Physical layer (PHY)—PCS and PMA block that consists of the 8B/10B encoder, word aligner, serializer,
and deserializer.

You can specify the datapath and wrapper for your design and generate them separately.

The TX andRXblocks in theDLL utilizes theAvalon-ST interface to transmit or receive data and theAvalon-
MM interface to access the CSRs. The TX and RX blocks operate on 32-bit data width per channel, where
the frame assembly packs the data into four octets per channel. Multiple TX and RX blocks can share the
clock and reset if the link rates are the same.
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Figure 4-1: Overview of the JESD204B IP Core Block Diagram
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Figure 4-2: JESD204B IP Core TX and RX Datapath Block Diagram

The JESD204B IP core utilizes the Avalon-ST source and sink interfaces, with unidirectional flow of data,
to transmit and receive data on the FPGA fabric interface.
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32-Bits Architecture

The JESD204B IP core consist of 32-bit internal datapath per lane. Thismeans that JESD204B IPCore expects
the data samples to be assembled into 32-bit data (4 octets) per lane in the transport layer before sending
the data to the Avalon-ST data bus. The JESD204 IP core operates in the link clock domain. The link clock
runs at (data rate/40) because it is operating in 32-bit data bus after 8B/10B encoding.

As the internal datapath of the core is 32-bits, the (F × K) value must be in the order of 4 to align the multi-
frame length on a 32-bit boundary. Apart from this, the deterministic latency counter values such as LMFC
counter, RBD counter, and Subclass 2 adjustment counter will be in link clock count instead of frame clock
count.

Avalon-ST Interface

The JESD204 IP core and transport layer in the design example use the Avalon-ST source and sink interfaces.
There is no backpressure mechanism implemented in this core. The JESD204B IP core expects continuous
stream of data samples from the upstream device.

Avalon-MM Interface

The Avalon-MM slave interface provides access to internal CSRs. The read and write data width is 32-bits
(DWORD access). The Avalon-MM slave is asynchronous to the txlink_clk, txframe_clk, rxlink_clk,
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and rxframe_clk clock domains. You are recommended to release the reset for the CSR configuration space
first. All run-time JESD204B configurations like L, F, M, N, N', CS, CF, and HD should be set before releasing
the reset for link and frame clock domain.

For the CSRs, write transfers have a writeWaitTime of 0 cycle while read transfers have a readWaitTime of
1 cycle.

Related Information
Avalon Interface Specification
More information about the Avalon-ST and Avalon-MM interfaces, including timing diagrams.

Transmitter
The transmitter block, which interfaces to DAC devices, takes one of more digital sample streams and
converts them into one or more serial streams.

The transmitter performs the following functions:

• Data scrambling
• Frame or lane alignment
• Character generation
• Serial lane monitoring
• 8B/10B encoding
• Data serializer

Figure 4-3: Transmitter Data Path Block Diagram
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The transmitter block consists of the following modules:

• TX CSR—manages the configuration and status registers.
• TX_CTL—manages the SYNC_N signal, state machine that controls the data link layer states, LMFC, and

also the deterministic latency throughout the link.
• TX Scrambler and Data Link Layer—takes in 32-bits of data that implements the Initial Lane Alignment

Sequence (ILAS), performs scrambling, lane insertion and frame alignment of characters.
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TX Data Link Layer
The JESD204B IP core TX data link layer includes three phases to establish a synchronized link—Code
Group Synchronization (CGS), Initial Lane Synchronization (ILAS), and User Data phase.

TX CGS

The CGS phase is achieved through the following process:

• Upon reset, the converter device (RX) issues a synchronization request by driving SYNC_N low. The
JESD204 TX IP core transmits a stream of /K/ = /K28.5/ symbols. The receiver synchronizes when it
receives four consecutive /K/ symbols.

• For Subclass 0, the RX converter devices deassert SYNC_N signal at the frame boundary. After all receivers
have deactivated their synchronization requests, the JESD204 TX IP core continues to emit /K/ symbols
until the start of the next frame. The core proceeds to transmit ILAS data sequence or encoded user data
if csr_lane_sync_en signal is disabled.

• For Subclass 1 and 2, the RX converter devices deassert SYNC_N signal at the LMFC boundary. After all
receivers deactivate the SYNC_N signal, the JESD204 TX IP core continues to transmit /K/ symbols until
the next LMFC boundary. At the next LMFC boundary, the JESD204B IP core transmits ILAS data
sequence. (There is no programmability to use a later LMFC boundary.)

TX ILAS

When lane alignment sequence is enabled through the csr_lane_sync_en register, the ILAS sequence is
transmitted after the CGS phase. The ILAS phase takes up four multi-frames. For Subclass 0 mode, you can
program the CSR (csr_ilas_multiframe) to extend the ILAS phase to a maximum of 256 multi-frames
before transitioning to the encoded user data phase. The ILAS data is not scrambled regardless of whether
scrambling is enabled or disabled.

The multi-frame has the following structure:

• Each multi-frame starts with a /R/ character (K28.0) and ends with a /A/ character (K28.3)
• The second multi-frame transmits the ILAS configuration data. The multi-frame starts with /R/ character

(K28.0), followed by /Q/ character (K28.4), and then followed by the link configuration data, which
consists of 14 octets as illustrated in the table below. It is then padded with dummy data and ends with
/A/ character (K28.3), marking the end of multi-frame.

• Dummy octets are an 8-bit counter and is always reset when it is not in ILAS phase.
• For a configuration of more than four multi-frames, the multi-frame follows the same rule above and is

padded with dummy data in between /R/ character and /A/ character.

Table 4-1: Link Configuration Data Transmitted in ILAS Phase

Description
BitsConfigura-

tion Octet LSB123456MSB

DID = Device IDDID[7:0]0
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Description
BitsConfigura-

tion Octet LSB123456MSB

ADJCNT = Number of adjustment
resolution steps (11)

BID = Bank ID

BID[3:0]ADJCNT[3:0]1

ADJDIR = Direction to adjust DAC
LMFC (11)

PHADJ = Phase adjustment request
(11)

LID = Lane ID

LID[4:0]PHADJADJDIR02

SCR = Scrambling enabled/disabled

L =Number of lanes per device (link)

L[4:0]00SCR3

F = Number of octets per frame per
lane

F[7:0]4

K = Number of frames per multi-
frame

K[4:0]0005

M=Number of converters per deviceM[7:0]6

CS = Number of control bits per
sample

N = Converter resolution

N[4:0]0CS[1:0]7

SUBCLASSV = Subclass version

N_PRIME = Total bits per sample

N_PRIME[4:0]SUBCLASSV[2:0]8

JESDV = JESD204 version

S =Number of samples per converter
per frame

S[4:0]JESDV[2:0]9

HD = High Density data format

CF = Number of control words per
frame clock per link

CF[4:0]00HD10

RES1 = Reserved. Set to 8'h00RES1[7:0]11

RES2 = Reserved. Set to 8'h00RES2[7:0]12

(11) Applies to Subclass 2 only.
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Description
BitsConfigura-

tion Octet LSB123456MSB

FCHK is the modulus 256 of the sum
of the 13 configuration octets above.

If you change any of the octets during
run-time, make sure to update the
new FCHK value in the register.

FCHK[7:0]; automatically calculated using run-time
configuration.

13

The JESD204 TX IP core also supports debug feature to continuously stay in ILAS phase without exiting.
You can enable this feature by setting the bit in csr_ilas_loop register. There are two modes of entry:

• RX asserts SYNC_N and deasserts it after CGS phase. This activity triggers the ILAS phase and the CSR
will stay in ILAS phase indefinitely until this setting changes.

• Link reinitialization through CSR is initiated. The JESD204B IP core transmits /K/ character and causes
the RX converter to enter CGS phase. After RX deasserts SYNC_N, the CSR enters ILAS phase and will
stay in that phase indefinitely until this setting changes.

In ILAS loop, the multi-frame transmission is the same where /R/ character (K28.0) marks the start of multi-
frame and /A/ character (K28.3) marks the end of multi-frame, with dummy data in between. The dummy
data is an increment of Dx.y.

User Data Phase
During the user data phase, character replacement at the end of frame and end of multi-frame is
opportunistically inserted so that there is no additional overhead for data bandwidth.

Character replacement for non-scrambled data

The character replacement for non-scrambled mode in the IP core follows these JESD204B specification
rules:

• At end of frame (not coinciding with end of multi-frame), which equals the last octet in the previous
frame, the transmitter replaces the octet with /F/ character (K28.7). However, if an alignment character
was transmitted in the previous frame, the original octet will be encoded.

• At the end of a multi-frame, which equals to the last octet in the previous frame, the transmitter replaces
the octet with /A/ character (K28.3), even if a control character was already transmitted in the previous
frame.

For devices that do not support lane synchronization, only /F/ character replacement is done. At every end
of frame, regardless of whether the end ofmulti-frame equals to the last octet in previous frame, the transmitter
encodes the octet as /F/ character (K28.7) if it fits the rules above.

Character replacement for scrambled data

The character replacement for scrambled data in the IP core follows these JESD204B specification rules:

• At end of frame (not coinciding with end of multi-frame), which equals to 0xFC (D28.7), the transmitter
encodes the octet as /F/ character (K28.7).

• At end ofmulti-frame, which equals to 0x7C, the transmitter replaces the current last octet as /A/ character
(K28.3).
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For devices that do not support lane synchronization, only /F/ character replacement is done. At every end
of frame, regardless of whether the end of multi-frame equals to 0xFC (D28.7), the transmitter encodes the
octet as /F/ character (K28.7) if it fits the rules above.

TX PHY Layer
The 8B/10B encoder encodes the data before transmitting them through the serial line. The 8B/10B encoding
has sufficient bit transition density (3-8 transitions per 10-bit symbol) to allow clock recovery by the receiver.
The control characters in this scheme allow the receiver to:

• synchronize to 10-bit boundary.
• insert special character to mark the start and end of frames and start and end of multi-frames.
• detect single bit errors.

The JESD204 IP core supports transmission order from MSB first as well as LSB first. For MSB first
transmission, the serialization of the left-most bit of 8B/10B code group (bit "a") is transmitted first.

Receiver
The receiver block, which interfaces to ADC devices, receives the serial streams from one or more TX blocks
and converts the streams into one or more sample streams.

The receiver performs the following functions:

• Data deserializer
• 8B/10B decoding
• Lane alignment
• Character replacement
• Data descrambling

Figure 4-4: Receiver Data Path Block Diagram
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The receiver block includes the following modules:

• RX CSR—manages the configuration and status registers.
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• RX_CTL—manages the SYNC_N signal, state machine that controls the data link layer states, LMFC, and
also the buffer release, which is crucial for deterministic latency throughout the link.

• RXScrambler andData Link Layer—takes in 32-bits of data that decodes the ILAS, performs descrambling,
character replacement as per the JESD204B specification, and error detection (code group error, frame
and lane realignment error).

RX Data Link Layer
The JESD204B IP core RX data link layer buffers incoming user data on all lanes until the RX elastic buffers
can be released. Special character substitution are done in the TX link so that the RX link can execute frame
and lane alignment monitoring based on the JESD204B specification.

RX CGS
The CGS phase is the link up phase that monitors the detection of /K28.5/ character.

The CGS phase is achieved through the following process:

• Once the word boundary is aligned, the RX PHY layer detects the /K28.5/ 20-bit boundary and indicate
that the character is valid.

• The receiver deasserts SYNC_N on the next frame boundary (for Subclass 0) or on the next LMFCboundary
(for Subclass 1 and 2) after the reception of four successive /K/ characters.

• After correct reception of another four 8B/10B characters, the receiver assumes full code group
synchronization. Error detected in this state machine is the code group error. Code group error always
trigger link reinitialization through the assertion of SYNC_N signal and this cannot be disabled through
the CSR. The CS state machine is defined as CS_INIT, CS_CHECK, and CS_DATA.

• The minimum duration for a synchronization request on the SYNC_N is five frames plus nine octets.

Frame Synchronization

After CGS phase, the receiver assumes that the first non-/K28.5/ character marks the start of frame and
multi-frame. If the transmitter emits an initial lane alignment sequence, the first non-/K28.5/ character will
be /K28.0/. Similar to the JESD204 TX IP core, the csr_lane_sync_en is set to 1 by default, thus the RX
core detects the /K/ character to /R/ character transition. If the csr_lane_sync_en is set to 0, the RX core
detects the /K/ character to the first data transition. An ILAS error and unexpected /K/ character is flagged
if either one of these conditions are violated.

The receiver assumes that a new frame starts in every F octets. The octet counter is used for frame alignment
and lane alignment.

Frame Alignment

The frame alignment ismonitored through the alignment character /F/. The transmitter inserts this character
at the end of frame. The /A/ character indicates the end of multi-frame. The character replacement algorithm
depends on whether scrambling is enabled or disabled, regardless of the csr_lane_sync_en register setting.

The alignment detection process:

• If two successive valid alignment characters are detected in the same position other than the assumed
end of frame—without receiving a valid or invalid alignment character at the expected position between
two alignment characters—the receiver realigns its frame to the new position of the received alignment
characters.

• If lane realignment can result in frame alignment error, the receiver issues an error.
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In the JESD204 RX IP core, the same flexible buffer is used for frame and lane alignment. Lane realignment
gives a correct frame alignment because lane alignment character doubles as a frame alignment character.
A frame realignment can cause an incorrect lane alignment or link latency. The course of action is for the
RX to request for reinitialization through SYNC_N. (12)

Lane Alignment

After the frame synchronization phase has entered FS_DATA, the lane alignment ismonitored via /A/ character
(/K28.3/) at the end of multi-frame. The first /A/ detection in the ILAS phase is important for the RX core
to determine the minimum RX buffer release for inter-lane alignment. There are two types of error that is
detected in lane alignment phase:

• Arrival of /A/ character from multiple lanes exceed one multi-frame.
• Misalignment detected during user data phase.

The realignment rules for lane alignment are similar to frame alignment:

• If two successive and valid /A/ characters are detected at the same position other than the assumed end
of multi-frame—without receiving a valid/invalid /A/ character at the expected position between two
/A/ characters—the receiver aligns the lane to the position of the newly received /A/ characters.

• If a recent frame alignment causes the loss of lane alignment, the receiver realigns the lane frame—which
is already at the position of the first received /A/ character—at the unexpected position.

ILAS Data

The JESD204 RX IP core captures 14 octets of link configuration data that are transmitted on the 2nd multi-
frame of the ILAS phase. The receiver waits for the reception of /Q/ character that marks the start of link
configuration data and then latch it into ILAS octets, which are per lane basis. You can read the 14 octets
captured in the link configuration data through the CSR. You need to first set the csr_ilas_data_sel
register to select which link configuration data lane it is trying to read from. Then, proceed to read from the
csr_ilas_octet register.

Initial Lane Synchronization

The receivers in Subclass 1 and Subclass 2 modes store data in a memory buffer (Subclass 0 mode does not
store data in the buffer but immediately releases them on the frame boundary as soon as the latest lane
arrives.). The RX IP core detects the start of multi-frame of user data per lane and then wait for the latest
lane data to arrive. The latest data is reported as RBD count (csr_rbd_count) value which you can read
from the status register. This is the earliest release opportunity of the data from the deskew FIFO (referred
to as RBD offset).

The JESD204 RX IP core supports RBD release at 0 offset and also provides programmable offset through
RBD count. By default, the RBD release can be programmed through the csr_rbd_offset to release at the
LMFC boundary. If you want to implement an early release mechanism, program it in the csr_rbd_offset
register. The csr_rbd_offset and csr_rbd_count is a counter based on the link clock boundary (not frame
clock boundary). Therefore, the RBD release opportunity is at every four octets.

(12) Dynamic frame realignment and correction is not supported.
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Figure 4-5: Subclass 1 Deterministic Latency and Support for Programmable Release Opportunity
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RX PHY Layer
The word aligner block identifies the MSB and LSB boundaries of the 10-bit character from the serial bit
stream. Manual alignment is set because the /K/ character must be detected in either LSB first or MSB first
mode. When the programmed word alignment pattern is detected in the current word boundary, the PCS
indicates a valid pattern in the rx_sync_status (mapped as pcs_valid to the IP core). The code synchro-
nization state is detected after the detection of the /K/ character boundary for all lanes.

In a normal operation, whenever synchronization is lost, JESD204 RX IP core always return back to the
CS_INIT state where the word alignment is initiated. For debug purposes, you can bypass this alignment by
setting the csr_patternalign_en register to 0.

The 8B/10B decoder decode the data after receiving the data through the serial line. The JESD204 IP core
supports transmission order from MSB first as well as LSB first.

The PHY layer can detect 8B/10B not-in-table (NIT) error and also running disparity error.
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Operation

Operating Modes
The JESD204B IP core supports Subclass 0, 1, and 2 operating modes.

Subclass 0

The JESD204 IP core maintains a LMFC counter that counts from 0 to (F × K/4)–1 and wraps around again.
The LMFC counter starts counting at the deassertion of SYNC_N signal from multiple DACs after
synchronization. This is to align the LMFC counter upon transmission and can only be done after all the
converter devices have deasserted its synchronization request signal.

Subclass 1

The JESD204 IP core maintains a LMFC counter that counts from 0 to (F × K/4)–1 and wraps around again.
The LMFC counter will reset within two link clock cycles after converter devices issue a common SYSREF
frequency to all the transmitters and receivers. The SYSREF frequencymust be the same for converter devices
that are grouped and synchronized together.

Table 4-2: Example of SYSREF Frequency Calculation

In this example, you can choose to perform one of the following options:

• provide two SYSREF and device clock, where the ADC groups share both the device clock and SYSREF (18.75
MHz and 9.375 MHz)

• provide one SYSREF (running at 9.375 MHz) and device clock for all the ADC and DAC groups because the
SYSREF period in the DAC is a multiplication of n integer.

SYSREF FrequencyConfigurationGroup

6 GHz / 40 / (2 x 16 / 4) = 18.75 MHz• LMF = 222
• K = 16
• Data rate = 6 Gbps

ADC Group 1 (2 ADCs)

6 GHz / 40 / (1 x 32 / 4) = 18.75 MHz• LMF = 811
• K = 32
• Data rate = 6 Gbps

ADC Group 2 (2 ADCs)

3 GHz / 40 / (2 x 16 / 4) = 9.375 MHz• LMF = 222
• K = 16
• Data rate = 3 Gbps

DAC Group 3 (2 DACs)

Subclass 2

The JESD204 IP core maintains a LMFC counter that counts from 0 to (F × K/4)–1 and wraps around again.
The LMFC count starts upon reset and the logic device always acts as the timing master. The converters
adjust their own internal LMFC to match the master's counter. The alignment of LMFC within the system
relies on the correct alignment of SYNC_N signal deassertion at the LMFC boundary.

The alignment of LMFC to RX logic is handled within the TX converter. The RX logic releases SYNC_N at
the LMFC tick and the TX converter adjust its internal LMFC to match the RX LMFC.
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For the alignment of LMFC to the TX logic, the JESD204TX IP core samples SYNC_N from theDAC receiver
and reports the relative phase difference between the DAC and TX logic device LMFC in the TX CSR
(dbg_phadj, dbg_adjdir, and dbg_adjcnt). Based on the reported value, you can calculate the adjustment
required. Then, to initiate the link reinitialization through the CSR, set the value in the TX CSR (csr_phadj,
csr_adjdir, and csr_adjcnt). The values on the phase adjustment are embedded in bytes 1 and 2 of the
ILAS sequence that is sent to the DAC during link initialization. On the reception of the ILAS, the DAC
adjusts its LMFC phase by step count value and sends back an error report with the new LMFC phase
information. This process may be repeated until the LMFC at the DAC and the logic device are aligned.

Scrambler/Descrambler
Both the scrambler and descrambler are designed in a 32-bit parallel implementation and the
scrambling/descrambling order starts from first octet with MSB first.

The JESD204 TX and RX IP core support scrambling by implementing a 32-bit parallel scrambler in each
lane. The scrambler and descrambler are located in the JESD204 IP MAC interfacing to the Avalon-ST
interface. You can enable or disable scrambling and this option applies to all lanes. Mixed mode operation,
where scrambling is enabled for some lanes, is not permitted.

The scrambling polynomial:

1 + x14 + x15

The descrambler can self-synchronize in eight octets. In a typical application where the reset value of the
scrambler seed is different from the converter device to FPGA logic device, the correct user data is recovered
in the receiver in two link clocks (due to the 32-bit architecture). The PRBS pattern checker on the transport
layer should always disable checking of the first eight octets from the JESD204 RX IP core.

SYNC_N Signal
For Subclass 0 implementation, the SYNC_N signal from the DAC converters in the same group path must
be combined.

In some applications, multiple converters are grouped together in the same group path to sample a signal
(referred as multipoint link). The FPGA can only start the LMFC counter and its transition to ILAS after all
the links deassert the synchronization request. The JESD204B TX IP core provides three signals to facilitate
this application. The SYNC_N is the direct signal from the DAC converters. The error signaling from SYNC_N

is filtered and sent out as dev_sync_n signal. For Subclass 0, you need to multiplex all the dev_sync_n signals
in the same multipoint link and then input them to the IP core through mdev_sync_n signal.

Altera CorporationJESD204B IP Core Functional Description

Send Feedback

4-13Scrambler/Descrambler
UG-01142
2014.06.30

mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20JESD204B%20IP%20Core%20Functional%20Description%20(UG-01142%202014.06.30)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


Figure 4-6: Subclass 0 — Combining the SYNC_N Signal for JESD204B TX IP Core
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For Subclass 1 implementation, you may choose to combine or not to combine the SYNC_N signal from the
converter device. If you implement two ADC converter devices as a multipoint link and one of the converter
is unable to link up, the functional link will still operate. You must manage the trace length for the SYSREF
signal and also the differential pair to minimize skew.

The SYNC_N is the direct signal from the DAC converters. The error signaling from SYNC_N is filtered and
sent out as dev_sync_n output signal. The dev_sync_n signal from the JESD204B TX IP core must loopback
into the mdev_sync_n signal of the same instance without combining the SYNC_N signal.

Apart from that, you must set the same RBD offset value (csr_rbd_offset) to all the JESD204B RX IP cores
within the same multipoint link for the RBD release (the latest lane arrival for each of the links). The JESD204
RX IP core will deskew and output the data when the RBD offset value is met. The total latency is consistent
in the system and is also the same across multiple resets. Setting a different RBD offset to each link or setting
an early release does not guarantee deterministic latency and data alignment.
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Figure 4-7: Subclass 1 — Combining the SYNC_N Signal for JESD204B TX IP Core
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Link Reinitialization
The JESD204B TX and RX IP core support link reinitialization.

There are two modes of entry for link reinitialization:

• Hardware initiated link reinitialization:

• For TX, the reception of SYNC_N for more than five frames and nine octets triggers link reinitialization.
• For RX, the loss of code group synchronization, frame alignment and lane alignment errors cause the

IP core to assert SYNC_N and request for link reinitialization.

• Software initiated link reinitialization—both the TX and RX IP core allow software to request for link
reinitialization.

• For TX, the IP core transmits /K/ character and wait for the receiver to assert SYNC_N to indicate that
it has entered CS_INIT state.

• For RX, the IP core asserts SYNC_N to request for link reinitialization.

Hardware initiated link reinitialization can be globally disabled through the csr_link_reinit_disable
register for debug purposes.

Hardware initiated link reinitialization can be issued as interrupt depending on the error type and interrupt
error enable. If lane misalignment has been detected as a result of a phase change in local timing reference,
the software can rely on this interrupt trigger to initiates a LMFC realignment. The realignment process
occurs by first resampling SYSREF and then issuing a link reinitialization request.
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Link Startup Sequence
Set the run-time LMF configuration when the txlink_rst_n or rxlink_rst_n signals are asserted. Upon
txlink_rst_n or rxlink_rst_n deassertion, the JESD204B IP core begins operation. The following sections
describe the detailed operation for each subclass mode.

TX (Subclass 0)

Upon reset deassertion, the JESD204B TX IP core is in CGS phase. SYNC_N deassertion from the converter
device enables the JESD204B TX IP core to exit CGS phase and enter ILAS phase (if csr_lane_sync_en =
1) or User Data phase (if csr_lane_sync_en = 0).

TX (Subclass 1)

Upon reset deassertion, the JESD204B TX IP core is in CGS phase. SYNC_N deassertion from the converter
device enables the JESD204B TX IP core to exit CGS phase. The IP core ensures that at least one SYSREF
rising edge is sampled before exiting CGS phase and entering ILAS phase. This is to prevent a race condition
where the SYNC_N is deasserted before SYSREF is sampled. SYSREF sampling is crucial to ensure deterministic
latency in the JESD204B Subclass 1 system.

TX (Subclass 2)

Similar to Subclass 1 mode, the JESD204B TX IP core is in CGS phase upon reset deassertion. The LMFC
alignment between the converter and IP core starts after SYNC_N deassertion. The JESD204B TX IP core
detects the deassertion of SYNC_N and compares the timing to its own LMFC. The required adjustment in
the link clock domain is updated in the register map. You need to update the final phase adjustment value
in the registers for it to transfer the value to the converter during the ILAS phase. The DAC adjusts the LMFC
phase and acknowledge the phase change with an error report. This error report contains the new DAC
LMFC phase information, which allows the loop to iterate until the phase between them is aligned.

RX (Subclass 0)

The JESD204B RX IP core drives and holds SYNC_N (dev_sync_n signal) low when it is in reset. Upon reset
deassertion, the JESD204B RX IP core checks if there is sufficient /K/ character to move its state machine
out of synchronization request. Once sufficient /K/ character is detected, the IP core deasserts SYNC_N.

RX (Subclass 1)

The JESD204B RX IP core drives and holds the SYNC_N (dev_sync_n signal) low when it is in reset. Upon
reset deassertion, the JESD204BRX IP core checks if there is sufficient /K/ character tomove its statemachine
out of synchronization request. The IP core also ensures that at least one SYSREF rising edge is sampled
before deasserting SYNC_N. This is to prevent a race condition where the SYNC_N is deasserted based on
internal free-running LMFC count instead of the updated LMFC count after SYSREF is sampled.

RX (Subclass 2)

The JESD204B RX IP core behaves the same as in Subclass 1 mode. In this mode, the logic device is always
the master timing reference. Upon SYNC_N deassertion, the ADC adjusts the LMFC timing to match the IP
core.

Error Reporting Through SYNC_N Signal
The JESD204 TX IP core can detect error reporting through SYNC_N when SYNC_N is asserted for two frame
clock periods (if F >= 2) or four frame clock periods (if F = 1). When the downstream device reports an error
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through SYNC_N, the TX IP core issues an interrupt. The TX IP core samples the SYNC_N pulse width using
the link clock.

For a special case of F = 1, two frame clock periods are less than one link clock. Therefore, the error signaling
from the receiver may be lost. You must program the converter device to extend the SYNC_N pulse to four
frame clocks when F = 1.

The JESD204 RX IP core does not report an error through SYNC_N signaling. Instead, the RX IP core issues
an interrupt when any error is detected.

You can check the csr_tx_err, csr_rx_err0, and csr_rx_err1 register status to determine the error types.

Clocking Scheme
This section describes the clocking scheme for the JESD204B IP core and transceiver.

Table 4-3: JESD204B IP Core Clocks

DescriptionFormulaClock Signal

The PLL reference clock used by the TX Transceiver
PLL or RX CDR.

This is also the recommended reference clock to the
Altera PLL IP Core (for Arria V or Stratix V devices)
or Altera IOPLL (for Arria10 devices).

PLL selection during IP
core generation

TX/RX Device Clock:

pll_ref_clk

The timing reference for the JESD204B IP core.The
link clock runs at data rate/40 because the IP core is
operating in a 32-bit data bus architecture after 8B/
10B encoding.

The JESD204B transport layer in the design example
requires both the link clock and frame clock to be
synchronous.

Data rate/40TX/RX Link Clock:

txlink_clk

rxlink_clk

The frame clock as per the JESD204B specification.
This clock is applicable to the JESD204B transport
layer and other upstream devices that run in frame
clock such as the PRBS generator/checker or any data
processing blocks that run at the same rate as the
frame clock.

The JESD204B transport layer in the design example
also supports running the frame clock in half rate or
quarter rate by using theFRAMECLK_DIVparameter.
The JESD204B transport layer requires both the link
clock and frame clock to be synchronous. For more
information, refer to the F1/F2_FRAMECLK_DIV
parameter description and its relationship to the frame
clock.

Data rate/(10 × F)TX/RX Frame Clock (in
design example):

txframe_clk

rxframe_clk
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DescriptionFormulaClock Signal

The serial clock is the bit clock to streamout serialized
data. The transceiver PLL supplies this clock and is
internal to the transceiver.

The parallel clock is for the transmitter PMAand PCS
within the PHY. This clock is internal to the
transceiver and is not exposed in the JESD204B IP
core.

For Arria V and Stratix V devices, these clocks are
internally generated as the transceiver PLL is
encapsulated within the JESD204B IP core's PHY.

For Arria 10 devices, you need to generate the
transceiver PLL based on the data rate and connect
the serial and parallel clock. These clocks are referred
to as *serial_clk and *bonding_clock in Arria 10
devices. Refer to theArria10 Transceiver PHY IP Core
User Guide for more information.

Internally derived from the
data rate during IP core
generation

TX/RX Transceiver
Serial Clock and Parallel
Clock

The link clock generated from the transceiver serial
or parallel clock for the TX path or the link clock
generated from the CDR for the RX path. This clock
has the same frequency as the TX/RX link clock and
is an output from the JESD204B IP core.

There is limited use for this clock. Only if the
JESD204B configuration is F=4 and operating at
Subclass 0 mode, this clock can be used as input for
both the txlink_clk and txframe_clk, or rxlink_
clk and rxframe_clk.

Data rate/40TX/RX PHY Clock:

txphy_clk

rxphy_clk

The configuration clock for the JESD204B IP core
CSR through the Avalon-MM interface.

75–125 MHzTX/RX AVS Clock:

jesd204_tx_avs_clk

jesd204_rx_avs_clk

The configuration clock for the transceiver CSR
through the Avalon-MM interface. This clock is
exported only when the transceiver dynamic
reconfiguration option is enabled.

This clock is only applicable for Arria 10 devices.

100 MHz–125 MHzTransceiver
Management Clock:

reconfig_clk

Device Clock
In a converter device, the sampling clock is typically the device clock. For the JESD204 IP core in an FPGA
logic device, the device clock is used as the transceiver PLL reference clock and also the core PLL reference
clock. The available frequency depends on the PLL type, bonding option, number of lanes, and device family.
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During IP core generation, the Quartus II software recommends the available device clock frequency for the
transceiver PLL based on the user selection.

You need to generate the Altera PLL IP core (in Arria V and Stratix V devices) or Altera IOPLL IP
core (in Arria 10 devices) to generate the link clock and frame clock. The link clock is used in the
JESD204 IP core (MAC) and the transport layer.

Note:

Based on the JESD204B specification, the device clock is the timing reference and is source synchronous
with SYSREF. Due to the clock network architecture in the FPGA, you are recommended to use the device
clock to generate the link clock and use the link clock as timing reference.

Figure 4-8: JESD204B Subsystem Clock Diagram (For Arria V and Stratix V Devices)

Clock Jitter Cleaner

Converter Device 2

Converter Device
device_clock

SYSREF

Trace Matching (1)

MAC PHY

Transceiver
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JESD204B IP Core

L
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Core PLL
FPGA Device

(Normal Mode) (3)

JESD204B
Transport

Layer

Avalon-ST

Link Clock

Frame Clock avs_clock

Test
Pattern

Generator/
Checker

Trace Matching (1)SYSREF

FPGA Device
Clock

Notes:
1. The device clock to the Altera core PLL and SYSREF must be trace matched. The device clock to the converter device and SYSREF must be

trace matched. The phase offset between the FPGA and the converter devices should be minimal.
2. For Arria 10 devices, the transceiver PLL is outside of the JESD204B IP core. For Arria V and Stratix V devices, the transceiver PLL is part of the JESD204B IP core.
3. The Altera core PLL provdes the link clock, frame clock, and AVS clock. The link clock and frame clock must be synchronous.

Related Information
Clock Correlation on page 4-21

Link Clock
The device clock is a timing reference for the JESD204B system. Due to the clock network architecture in
the FPGA, JESD204 IP core does not use the device clock to clock the SYSREF signal because the GCLK or
RCLK is not fully compensated. You are recommended to use the Altera PLL IP core (in Arria V and Stratix
V devices) or Altera IOPLL IP core (in Arria 10 devices) to generate both the link clock and frame clock.
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TheAltera PLL IP coremust operate innormalmode or source synchronousmode to achieve the following
state:

• the GCLK and RCLK clock network latency is fully compensated.
• the link clock and frame clock at the registers are phase-aligned to the input of the clock pin.

To provide consistency across the design regardless of frame clock and sampling clock, the link clock is used
as a timing reference.

The Altera PLL IP core should provide both the frame clock and link clock from the same PLL as these two
clocks are treated as synchronous in the design.

For Subclass 0 mode, the device clock is not required to sample the SYSREF signal edge. The link clock does
not need to be phase compensated to capture SYSREF. Therefore, you can generate both the link clock and
frame clock using direct mode in the Altera PLL IP core. If F = 4, where link clock is the same as the frame
clock, you can use the parallel clock output from the transceiver (txphy_clk or rxphy_clk signal).

Related Information
Clock Correlation on page 4-21

Local Multi-Frame Clock
The Local Multi-Frame Clock (LMFC) is a counter generated from the link clock and depends on the F and
K parameter. The K parameter must be set between 1 to 32 and meet the requirement of at least a minimum
of 17 octets and a maximum of 1024 octets in a single multi-frame. In a 32-bit architecture, the K × F must
also be in the order of four.

In a Subclass 1 deterministic latency system, the SYSREF frequency is distributed to the devices to align them
in the system. The SYSREF resets the internal LMFC clock edge when the sampled SYSREF signal's rising
edge transition from 0 to 1. Due to source synchronous signaling of SYSREF with respect to the device clock
sampling (provided from the clock chip), the JESD204 IP core does not directly use the device clock to sample
SYSREF but instead uses the link clock to sample SYSREF. Therefore, the Altera PLL IP core that provides
the link clock must to be in normal mode to phase-compensate the link clock to the device clock.

Based on hardware testing, to get a fixed latency, at least 32 octets are recommended in an LMFC period so
that there is a margin to tune the RBD release opportunity to compensate any lane-to-lane deskew across
multiple resets. If F = 1, then K = 32 would be optimal as it provides enough margin for system latency
variation. If F = 2, then K = 16 and above (18/20/22/24/26/28/30/32) is sufficient to compensate lane-to-lane
deskew.

The JESD204B IP core implements the local multi-frame clock as a counter that increments in link clock
counts. The local multi-frame clock counter is equal to (F × K/4) in link clock as units. The rising edge of
SYSREF resets the localmulti-frame clock counter to 0. There are twoCSRbits that controls SYSREF sampling.

• csr_sysref_singledet—resets the localmulti-frame clock counter once and automatically cleared after
SYSREF is sampled. This register also prevents CGS exit to bypass SYSREF sampling.

• csr_sysref_alwayson—resets the local multi-frame clock counter at every rising edge of SYSREF that
it detects. This register also enables the SYSREF period checker. If the provided SYSREF period violates
the F and K parameter, an interrupt is triggered. However, this register does not prevent CGS-SYSREF
race condition.

The following conditions occur if both CSR bits are set:

• resets the local multi-frame clock counter at every rising edge of SYSREF.
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• prevents CGS-SYSREF race condition.
• checks SYSREF period.

Related Information
Clock Correlation on page 4-21

Clock Correlation
This section describes the clock correlation between the device clock, link clock, frame clock, and local
multi-frame clock.

Example 1

Targeted device with LMF=222, K=16 and Data rate = 6.5 Gbps

Device Clock selected = 325 MHz (obtained during IP core generation)

Link Clock = 6.5 GHz/40 = 162.5 MHz Frame Clock = 6.5 GHz/(10x2) = 325 MHz

Local Multi-frame clock = 325 MHz / 16 = 20.3125 MHz

SYSREF Frequency = Local Multi-frame Clock / n; (n = integer; 1, 2, …)

Local multi-frame clock counter = (F × K/4) = (2×16/4) = 8 link clocks (13)

Example 2

Targeted device with LMF=244, K=16 and Data rate = 5.0 Gbps

Device Clock selected = 125 MHz (obtained during IP core generation)

Link Clock = 5 GHz/40 = 125 MHz (14)

Frame Clock = 5 GHz /(10×4) = 125 MHz (14)

Local Multi-frame clock = 125 MHz / 16 = 7.8125 MHz

SYSREF Frequency = Local Multi-frame Clock / n; (n = integer; 1, 2, …)

Local multi-frame clock counter = (F × K/4) = (4×8/4) = 8 link clocks (13)

Example 3

Targeted device with LMF=421, K=32 and Data rate = 10.0 Gbps

Device Clock selected = 250 MHz (obtained during IP core generation)

Link Clock = 10 GHz/40 = 250 MHz

Frame Clock = 10 GHz/(10×1) = 1 GHz (15)

Local Multi-frame clock = 1 GHz / 32 = 31.25 MHz

(13) Eight link clocks means that the local multi-frame clock counts from value 0 to 7 and then loopback to 0.
(14) The link clock and frame clock are running at the same frequency. You only need to generate one clock from

the Altera PLL or Altera IO PLL IP core.
(15) For this example, the frame clock may not be able to run up to 1 GHz in the FPGA fabric. The JESD204B

transport layer in the design example supports running the data stream of half rate (1 GHz/2 = 500 MHz), at
two times the data bus width or of quarter rate (1GHz/4 = 250MHz), at four times the data bus width.
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SYSREF Frequency = Local Multi-frame Clock / n; (n = integer; 1, 2, …)

Local multi-frame clock counter = (F × K/4) = (1×32/4) = 8 link clocks (13)

Related Information

• Device Clock on page 4-18

• Link Clock on page 4-19

• Local Multi-Frame Clock on page 4-20

Reset Scheme
All resets in the JESD204B IP core are synchronous reset signals and should be asserted and deasserted
synchronously.

Ensure that the resets are synchronized to the respective clocks for reset assertion and deassertion.Note:

Table 4-4: JESD204B IP Core Resets

DescriptionAssociated ClockReset Signal

Active low reset controlled by the clock and reset
unit.

Thetxlink_rst_n/rxlink_rst_n andtxframe_
rst_n /rxframe_rst_n signals can be deasserted
at the same time. These resets can only be
deasserted after you configure the CSR registers.

TX/RX Link Clocktxlink_rst_n

rxlink_rst_n

Active low reset controlled by the clock and reset
unit. If the TX/RX link clock and the TX/RX
frame clock has the same frequency, both can
share the same reset.

TX/RX Frame Clocktxframe_rst_n

rxframe_rst_n

Active high reset controlled by the transceiver
reset controller. This signal resets the TX/RX
PMA.

The link clock, frame clock, andAVS clock reset
signals (txlink_rst_n/rxlink_rst_n,txframe_
rst_n/rxframe_rst_n and jesd204_tx_avs_

rst_n/jesd204_rx_avs_rst_n) can only be
deasserted after the transceiver comes out of
reset. (16)

Transceiver Native PHY
Analog Reset

tx_analogreset[L-1:0]

rx_analogreset[L-1:0]

(16) Refer to the Altera Transceiver PHY IP Core User Guide for the timing diagram of the tx_analogreset,
rx_analogreset, tx_digitalreset, and rx_digitalreset signals.
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DescriptionAssociated ClockReset Signal

Active high reset controlled by the transceiver
reset controller. This signal resets the TX/RX
PCS.

The link clock, frame clock, andAVS clock reset
signals (txlink_rst_n/rxlink_rst_n,txframe_
rst_n/rxframe_rst_n and jesd204_tx_avs_

rst_n/jesd204_rx_avs_rst_n) can only be
deasserted after the transceiver comes out of
reset.
(16)

Transceiver Native PHY
Digital Reset

tx_digitalreset[L-1:0]

rx_digitalreset[L-1:0]

Active low reset controlled by the clock and reset
unit. Typically, both signals can be deasserted
after the core PLL and transceiver PLL are locked
and out of reset. If you want to dynamically
modify the LMF at run-time, you can program
the CSRs after AVS reset is deasserted. This
phase is referred to as the configuration phase.

After the configuration phase is complete, then
only the txlink_rst_n/rxlink_rst_n and
txframe_rst_n/rxframe_rst_n signals can be
deasserted.

TX/RXAVS (CSR)Clockjesd204_tx_avs_rst_n

jesd204_rx_avs_rst_n

Related Information
Altera Transceiver PHY IP Core User Guide

Signals
The JESD204B IP core signals are listed by interface:

• Transmitter
• Receiver

You should terminate any unused signals.Note:
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Transmitter

Table 4-5: Transmitter Signals

DescriptionDirectionWidthSignalInterface

Transceiver reference clock signal. The
reference clock selection depends on the
FPGA device family and data rate.

This signal is only applicable for V series
FPGA variants.

Input1pll_ref_clk

Clocks
andResets

TX link clock signal. This clock is equal
to the TX data rate divided by 40. This
clock must have the same frequency as
the txphy_clk signal but can be
differential in phase due to a different
clock network.

For Subclass 1, you cannot use the output
of txphy_clk signal as txlink_clk signal
. To sample SYSREF correctly, the core
PLLmust provide the txlink_clk signal
and must be configured as normal
operating mode.

Input1txlink_clk

TX parallel clock output for the TX PCS.
This clockmust have the same frequency
as txlink_clk signal.

This clock is output as an optional port
for user if the txlink_clk and txframe_

clk signals are operating at the same
frequency in Subclass 0 operating mode.

OutputLtxphy_clk[]

Reset for the TX link clock signal. This
reset is an active low signal.

Input1txlink_rst_n_reset_n

Reset for the transceiver PCS block. This
reset is an active high signal.

InputLtx_digitalreset[]
(17)

Reset for the transceiver PMAblock. This
reset is an active high signal.

InputLtx_analogreset[]
(17)

Input/
Output

Lpll_locked[]
(17)
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DescriptionDirectionWidthSignalInterface

PLL locked signal for the hard
transceiver. This signal is asserted to
indicate that the TX transceiver PLL is
locked.

This signal is an output signal for V series
FPGA variants but an input signal for 10
series FPGA variants and above.

TX calibration in progress signal. This
signal is asserted to indicate that the TX
transceiver calibration is in progress.

OutputLtx_cal_busy[]
(17)

TX transceiver PLL power down signal.Input• 1 if bonding
mode = "xN"

pll_powerdown[]
(17)

This signal is only applicable for V series
FPGA variants.• L if bonding

mode =
feedback
compensation

The transceiver PLL bonding clocks. The
transceiver PLL generation provides these
clocks.

This signal is only available if you select
Bondedmode forArria 10 FPGAvariants.

Input6tx_bonding_clocks

(Single Channel)

tx_bonding_clocks_

ch<0..L-1> (Multiple
Channels)

The transceiver PLL serial clock. This is
the serializer clock in the PMA. The
transceiver PLL generation provides these
clocks.

This signal is only available if you select
Non-bonded mode for Arria 10 FPGA
variants.

Input1tx_serial_clk0 (Single
Channel)

tx_serial_clk0_

ch<0..L-1> (Multiple
Channels)

(17) The Transceiver PHY Reset Controller IP Core controls this signal.
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DescriptionDirectionWidthSignalInterface

Differential high speed serial output data.
The clock is embedded in the serial data
stream.

OutputLtx_serial_data[]

Transceiver

Reconfiguration signals from the
Transceiver Reconfiguration Controller
IP core to the PHY device.

This signal is only applicable for V series
FPGA variants.

You must connect these signals to the
Transceiver Reconfiguration Controller
IP core regardless of whether run-time
reconfiguration is enabled or disabled.
The Transceiver Reconfiguration
Controller IP core also supports various
calibration function during transceiver
power up.

Input• (L+1)*70 if
bondingmode
= "xN"

• L*140 if
bondingmode
= feedback
compensation

reconfig_to_xcvr[]

Reconfiguration signals to the
Transceiver Reconfiguration Controller
IP core.

This signal is only applicable for V series
FPGA variants.

You must connect these signals to the
Transceiver Reconfiguration Controller
IP core regardless of whether run-time
reconfiguration is enabled or disabled.
The Transceiver Reconfiguration
Controller IP core also supports various
calibration function during transceiver
power up.

Output• (L+1)*46 if
bondingmode
= "xN"

• L*92 if
bondingmode
= feedback
compensation

reconfig_from_xcvr[]

The Avalon-MM clock input. The
frequency range is 100–125 MHz.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Input1reconfig_clk

Reset signal for the Transceiver
Reconfiguration Controller IP core. This
signal is active high and level sensitive.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Input1reconfig_reset

JESD204B IP Core Functional DescriptionAltera Corporation

Send Feedback

UG-01142
Transmitter4-26 2014.06.30

mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20JESD204B%20IP%20Core%20Functional%20Description%20(UG-01142%202014.06.30)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


DescriptionDirectionWidthSignalInterface

reconfig_avmm_

address[]

The Avalon-MM address.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Inputlog2L*1024

The input data.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Input32reconfig_avmm_

writedata[]

The output data.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Output32reconfig_avmm_

readdata[]

Write signal. This signal is active high.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Input1reconfig_avmm_write

Read signal. This signal is active high.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Input1reconfig_avmm_read

Wait request signal.

This signal is only available if you enable
dynamic reconfiguration for Arria 10
FPGA variants.

Output1reconfig_avmm_

waitrequest
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DescriptionDirectionWidthSignalInterface

Indicates a 32-bit user data at txlink_
clk clock rate, where four octets are
packed into a 32-bit data width per lane.
The data format is big endian.

The first octet is located at bit[31:24],
followed by bit[23:16], bit[15:8], and the
last octet is bit[7:0]. Lane 0 data is always
located in the lower 32-bit data. If more
than one lane is instantiated, lane 1 is
located at bit[63:32], with the first octet
position at bit[63:56].

InputL*32jesd204_tx_link_

data[]

Avalon-
ST

Indicates whether the data from the
transport layer is valid or invalid. The
Avalon-ST sink interface in the TX core
cannot be backpressured and assumes
that data is always valid on every cycle
when thejesd204_tx_link_ready signal
is asserted.

• 0—data is invalid
• 1—data is valid

Input1jesd204_tx_link_valid

Indicates that the Avalon-ST sink
interface in the TX core is ready to accept
data. TheAvalon-ST sink interface asserts
this signal on the JESD204B link state of
USER_DATA phase. The ready latency is
0.

Output1jesd204_tx_link_ready

Indicates that the Avalon-ST sink
interface in the transport layer is ready
to accept data. The Avalon-ST sink
interface asserts this signal on the
JESD204B link state of ILAS 4th

multiframe and also the USER_DATA
phase. The ready latency is 0.

Output1jesd204_tx_frame_

ready
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DescriptionDirectionWidthSignalInterface

The Avalon-MM interface clock signal.
This clock is asynchronous to all the
functional clocks in the JESD204B IP
core. The JESD204B IP core can handle
any cross clock ratio and therefore the
clock frequency can range from 75 MHz
to 125 MHz.

Input1jesd204_tx_avs_clk

Avalon-
MM

This reset is associatedwith the jesd204_
tx_avs_clk signal. This reset is an active
low signal. You can assert this reset signal
asynchronously but must deassert it
synchronously to the jesd204_tx_avs_
clk signal. After you deassert this signal,
the CPU can configure the CSRs.

Input1jesd204_tx_avs_rst_n

When this signal is present, the slave port
ignores all Avalon-MMsignals unless this
signal is asserted. This signal must be
used in combination with read or write.
If the Avalon-MM bus does not support
chip select, you are recommended to tie
this port to 1.

Input1jesd204_tx_avs_

chipselect

For Avalon-MM slave, the interconnect
translates the byte address into a word
address in the address space so that each
slave access is for a word of data. For
example, address = 0 selects the first word
of the slave and address = 1 selects the
second word of the slave.

Input8jesd204_tx_avs_

address[]

32-bit data for write transfers. The width
of this signal and the jesd204_tx_avs_
readdata[31:0] signalmust be the same
if both signals are present

Input32jesd204_tx_avs_

writedata[]

This signal is asserted to indicate a read
transfer. This is an active high signal and
requires the jesd204_tx_avs_
readdata[31:0] signal to be in use.

Input1jesd204_tx_avs_read

This signal is asserted to indicate a write
transfer. This is an active high signal and
requires the jesd204_tx_avs_
writedata[31:0] signal to be in use.

Input1jesd204_tx_avs_write

Output32
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DescriptionDirectionWidthSignalInterface

jesd204_tx_avs_

readdata[]

32-bit data driven from the Avalon-MM
slave to master in response to a read
transfer.

This signal is asserted by theAvalon-MM
slave to indicate that it is unable to
respond to a read or write request. The
JESD204B IP core ties this signal to 0 to
return the data in the access cycle.

Output1jesd204_tx_avs_

waitrequest
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DescriptionDirectionWidthSignalInterface

SYSREF signal for JESD204B Subclass 1
implementation.

For Subclass 0 and Subclass 2 mode, tie-
off this signal to 0.

Input1sysref

JESD204

Indicates SYNC_N from the converter
device or receiver. This is an active low
signal and is asserted 0 to indicate a
synchronization request or error
reporting from the converter device.

To indicate a synchronization request,
the converter device must assert this
signal for at least five frames and nine
octets.

To indicate an error reporting, the
converter device must ensure that the
pulse is at least one cycle of the txlink_
clk signal or two cycles of the txframe_
clk signal (whichever period is longer).

Input1sync_n

Indicates a clean synchronization request.
This is an active low signal and is asserted
0 to indicate a synchronization request
only. The sync_n signal error reporting
is being masked out of this signal. This
signal is also asserted during software-
initiated synchronization.

Output1dev_sync_n

Indicates a multidevice synchronization
request. Synchronize signal combination
should be done externally and then input
to the JESD204B IP core through this
signal.

• For subclass 0—combine the dev_
sync_n signal from all multipoint
links before connecting to the mdev_
sync_n signal.

• For subclass 1—connect the dev_
sync_n signal to the mdev_sync_n
signal for each link respectively.

In a single link instance where multide-
vice synchronization is not needed, tie
the  dev_sync_n signal to this signal.

Input1mdev_sync_n
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DescriptionDirectionWidthSignalInterface

Optional signal to indicate an empty data
stream due to invalid data. This signal is
asserted high to indicate an error during
data transfer from the transport layer to
the TX core.

Input1jesd204_tx_frame_

error

CSR

Indicates the number of active lanes for
the link. The transport layer can use this
signal as a run-time parameter.

Output5csr_l[]

Indicates the number of octets per frame.
The transport layer can use this signal as
a run-time parameter.

Output8csr_f[]

Indicates the number of frames per
multiframe. The transport layer can use
this signal as a run-time parameter.

Output5csr_k[]

Indicates the number of converters for
the link. The transport layer can use this
signal as a run-time parameter.

Output8csr_m[]

Indicates the number of control bits per
sample. The transport layer can use this
signal as a run-time parameter.

Output2csr_cs[]

Indicates the converter resolution. The
transport layer can use this signal as a
run-time parameter.

Output5csr_n[]

Indicates the total number of bits per
sample. The transport layer can use this
signal as a run-time parameter.

Output5csr_np[]

Indicates the number of samples per
converter per frame cycle. The transport
layer can use this signal as a run-time
parameter.

Output5csr_s[]

Indicates the high density data format.
The transport layer can use this signal as
a run-time parameter.

Output1csr_hd

Indicates the number of control words
per frame clock period per link. The
transport layer can use this signal as a
run-time parameter.

Output5csr_cf[]
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DescriptionDirectionWidthSignalInterface

Indicates which lane is powered down.
You need to set this signal if you have
configured the link and want to reduce
the number of active lanes.

OutputLcsr_lane_powerdown[]

CSR

Indicates the address space that is
reserved for DLL testing within the
JESD204B IP core.

• 0—reserved for the IP core.
• 1—program different tests in the

transport layer.

Refer to csr_tx_testmode register.

Output4csr_tx_testmode[]

A 32-bit fixed data pattern for the test
mode. (18)

Output32csr_tx_testpattern_

a[]

A 32-bit fixed data pattern for the test
mode. (18)

Output32csr_tx_testpattern_

b[]

A 32-bit fixed data pattern for the test
mode. (18)

Output32csr_tx_testpattern_

c[]

A 32-bit fixed data pattern for the test
mode. (18)

Output32csr_tx_testpattern_

d[]

Interrupt pin for the JESD204B IP core.
Interrupt is asserted when an error
condition or synchronization request is
detected.

Output1jesd204_tx_intOut-of-
band
(OOB)

Optional signal for parallel data from the
DLL in TX to RX loopback testing.
(19)

OutputL*32jesd204_tx_dlb_data[]

Debug or
Testing Optional signal to indicate the K

character value for each byte in TX to RX
loopback testing.
(19)

OutputL*4jesd204_tx_dlb_kchar_

data[]

(18) You can use this signal in the transport layer to configure programmable test pattern.
(19) This signal is only for internal testing purposes. You can leave this signal disconnected.
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Receiver

Table 4-6: Receiver Signals

DescriptionDirectionWidthSignalInterface

Transceiver reference clock signal.Input1pll_ref_clk

Clocks and
Resets

RX link clock signal used by the Avalon-ST
interface. This clock is equal to RX data rate
divided by 40.

For Subclass 1, you cannot use the output of
rxphy_clk signal as rxlink_clk signal. To
sample SYSREF correctly, the core PLLmust
provide the rxlink_clk signal and must be
configured as normal operating mode.

Input1rxlink_clk

Reset for the RX link clock signal. This reset
is an active low signal.

Input1rxlink_rst_n_reset_n

Recovered clock signal. This clock is derived
from the clock data recovery (CDR) and the
frequency depends on the JESD204B IP core
data rate.

OutputLrxphy_clk[]

Reset for the transceiver PCS block. This
reset is an active high signal.

InputLrx_digitalreset[]
(20)

Reset for the CDR and transceiver PMA
block. This reset is an active high signal.

InputLrx_analogreset[]
(20)

This signal is asserted to indicate that the RX
CDR PLL is locked to the RX data and the
RX CDR has changed from LTR to LTD
mode.

OutputLrx_islockedtodata[]
(20)

RX calibration in progress signal. This signal
is asserted to indicate that the RX transceiver
calibration is in progress.

OutputLrx_cal_busy[]
(20)

(20) The Transceiver PHY Reset Controller IP Core controls this signal.
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DescriptionDirectionWidthSignalInterface

Differential high speed serial input data. The
clock is recovered from the serial data
stream.

InputLrx_serial_data[]

Transceiver

Dynamic reconfiguration input for the hard
transceiver.

This signal is only applicable for V series
FPGA variants.

You must connect these signals to the
Transceiver Reconfiguration Controller IP
core regardless of whether run-time
reconfiguration is enabled or disabled. The
Transceiver Reconfiguration Controller IP
core also supports various calibration
function during transceiver power up.

InputL*70reconfig_to_xcvr[]

Dynamic reconfiguration output for the hard
transceiver.

This signal is only applicable for V series
FPGA variants.

You must connect these signals to the
Transceiver Reconfiguration Controller IP
core regardless of whether run-time
reconfiguration is enabled or disabled. The
Transceiver Reconfiguration Controller IP
core also supports various calibration
function during transceiver power up.

OutputL*46reconfig_from_xcvr[]

TheAvalon-MMclock input. The frequency
range is 100–125 MHz.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

Input1reconfig_clk

Reset signal for the Transceiver Reconfigura-
tion Controller IP core. This signal is active
high and level sensitive.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

Input1reconfig_reset

Inputlog2L*1024reconfig_avmm_

address[]
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DescriptionDirectionWidthSignalInterface

The Avalon-MM address.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

The input data.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

Input32reconfig_avmm_

writedata[]

The output data.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

Output32reconfig_avmm_

readdata[]

Write signal. This signal is active high.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

Input1reconfig_avmm_write

Read signal. This signal is active high.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

Input1reconfig_avmm_read

Wait request signal.

This signal is only available if you enable
dynamic reconfiguration forArria 10 FPGA
variants.

Output1reconfig_avmm_

waitrequest
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DescriptionDirectionWidthSignalInterface

Indicates a 32-bit data from the DLL to the
transport layer. The data format is big
endian, where the earliest octet is placed in
bit [31:24] and the latest octet is placed in
bit [7:0].

OutputL*32jesd204_rx_link_data[]

Avalon-ST

Indicates whether the data to the transport
layer is valid or invalid. The Avalon-ST
source interface in the RX core cannot be
backpressured and will transmit the data
when the jesd204_rx_data_valid signal is
asserted.

• 0—data is invalid
• 1—data is valid

Output1jesd204_rx_link_valid

Indicates that the Avalon-ST sink interface
in the transport layer is ready to receive data.

Input1jesd204_rx_link_ready

Indicates an empty data stream due to
invalid data. This signal is asserted high to
indicate an error during data transfer from
the RX core to the transport layer.

Input1jesd204_rx_frame_error
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DescriptionDirectionWidthSignalInterface

TheAvalon-MM interface clock signal. This
clock is asynchronous to all the functional
clocks in the JESD204B IP core. The
JESD204B IP core can handle any cross clock
ratio and therefore the clock frequency can
range from 75 MHz to 125 MHz.

Input1jesd204_rx_avs_clk

Avalon-
MM

This reset is associated with the jesd204_
rx_avs_clk signal. This reset is an active
low signal. You can assert this reset signal
asynchronously but must deassert it
synchronously to the jesd204_rx_avs_clk
signal. After you deassert this signal, the
CPU can configure the CSRs.

Input1jesd204_rx_avs_rst_n

When this signal is present, the slave port
ignores all Avalon-MM signals unless this
signal is asserted. This signal must be used
in combination with read or write. If the
Avalon-MM bus does not support chip
select, you are recommended to tie this port
to 1.

Input1jesd204_rx_avs_

chipselect

For Avalon-MM slave, the interconnect
translates the byte address into a word
address in the address space so that each
slave access is for a word of data. For
example, address = 0 selects the first word
of the slave and address = 1 selects the
second word of the slave.

Input8jesd204_rx_avs_

address[]

32-bit data for write transfers. The width of
this signal and the jesd204_rx_avs_
readdata[31:0] signal must be the same if
both signals are present.

Input32jesd204_rx_avs_

writedata[]

This signal is asserted to indicate a read
transfer. This is an active high signal and
requires the jesd204_rx_avs_
readdata[31:0] signal to be in use.

Input1jesd204_rx_avs_read

This signal is asserted to indicate a write
transfer. This is an active high signal and
requires the jesd204_rx_avs_
writedata[31:0] signal to be in use.

Input1jesd204_rx_avs_write

32-bit data driven from the Avalon-MM
slave tomaster in response to a read transfer.

Output32jesd204_rx_avs_

readdata[]
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DescriptionDirectionWidthSignalInterface

This signal is asserted by the Avalon-MM
slave to indicate that it is unable to respond
to a read or write request. The JESD204B IP
core ties this signal to 0 to return the data in
the access cycle.

Output1jesd204_rx_avs_

waitrequest
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DescriptionDirectionWidthSignalInterface

SYSREF signal for JESD204B Subclass 1
implementation.

For Subclass 0 and Subclass 2 mode, tie-off
this signal to 0.

Input1sysref

JESD204

Indicates a SYNC~ from the receiver. This
is an active low signal and is asserted 0 to
indicate a synchronization request. Instead
of reporting the link error through this
signal, the JESD204B IP core uses the
jesd204_rx_int signal to interrupt the
CPU.

Output1dev_sync_n

Indicates a start of frame.

• [3]—start of frame for jesd204_rx_
link_data[31:24]

• [2]—start of frame for jesd204_rx_
link_data[23:16]

• [1]—start of frame for jesd204_rx_
link_data[15:8]

• [0]—start of frame for jesd204_rx_
link_data[7:0]

Output4sof[]

Indicates a start of multiframe.

• [3]—start ofmultiframe for jesd204_rx_
link_data[31:24]

• [2]—start ofmultiframe for jesd204_rx_
link_data[23:16]

• [1]—start ofmultiframe for jesd204_rx_
link_data[15:8]

• [0]—start ofmultiframe for jesd204_rx_
link_data[7:0]

Output4somf[]

Indicates that all lanes for this device are
aligned.

Output1dev_lane_aligned

Aligns all lanes for this device.

For multidevice synchronization, multiplex
all the dev_lane_aligned signals before
connecting to this signal pin.

For single device support, connect the dev_
lane_aligned signal back to this signal.

Input1alldev_lane_aligned
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DescriptionDirectionWidthSignalInterface

Indicates the number of active lanes for the
link. The transport layer can use this signal
as a run-time parameter.

Output5csr_l[]

CSR

Indicates the number of octets per frame.
The transport layer can use this signal as a
run-time parameter.

Output8csr_f[]

Indicates the number of frames per
multiframe. The transport layer can use this
signal as a run-time parameter.

Output5csr_k[]

Indicates the number of converters for the
link. The transport layer can use this signal
as a run-time parameter.

Output8csr_m[]

Indicates the number of control bits per
sample. The transport layer can use this
signal as a run-time parameter.

Output2csr_cs[]

Indicates the converter resolution. The
transport layer can use this signal as a run-
time parameter.

Output5csr_n[]

Indicates the total number of bits per sample.
The transport layer can use this signal as a
run-time parameter.

Output5csr_np[]

Indicates the number of samples per
converter per frame cycle. The transport
layer can use this signal as a run-time
parameter.

Output5csr_s[]

Indicates the high density data format. The
transport layer can use this signal as a run-
time parameter.

Output1csr_hd

Indicates the number of control words per
frame clock period per link. The transport
layer can use this signal as a run-time
parameter.

Output5csr_cf[]

Indicates which lane is powered down. You
need to set this signal if you have configured
the link and want to reduce the number of
active lanes.

OutputLcsr_lane_powerdown[]

Output4csr_rx_testmode[]
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DescriptionDirectionWidthSignalInterface

Indicates the address space that is reserved
forDLL testingwithin the JESD204B IP core.

• 0—reserved for the IP core.
• 1—program different tests in the

transport layer.

Refer to the csr_rx_testmoderegister.

Interrupt pin for the JESD204B IP core.
Interrupt is assertedwhen an error condition
or synchronization request is detected.

Output1jesd204_rx_intOut-of-
band
(OOB)

Optional signal for parallel data to the DLL
in TX to RX loopback testing. (21)

InputL*32jesd204_rx_dlb_data[]

Debug or
Testing

Optional signal to indicate valid data for each
byte in TX to RX loopback testing. (21)

InputLjesd204_rx_dlb_data_

valid[]

Optional signal to indicate the K character
value for each byte in TX to RX loopback
testing.
(21)

InputL*4jesd204_rx_dlb_kchar_

data[]

Optional signal to indicate 8B/10B error. (21)InputL*4jesd204_rx_dlb_

errdetect[]

Optional signal to indicate running disparity.
(21)

InputL*4jesd204_rx_dlb_

disperr[]

Registers
The JESD204B IP core supports a basic one clock cycle transaction bus. There is no support for burst mode
and wait-state feature (the avs_waitrequest signal is tied to 0). The JESD204B IP core Avalon-MM slave
interface has a data width of 32 bits and is implemented based on word addressing. The Avalon-MM slave
interface does not support byte enable access.

Each write transfer has a writeWaitTime of 0 cycle while a read transfer has a readWaitTime of 1 cycle and
readLatency of 1 cycle.

The following HTML files list the TX and RX core registers.

• TX register map
• RX register map

(21) This signal is only for internal testing purposes. If you disable loopback test, tie this signal low.
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JESD204B IP Core Design Example
The design example entity consists of various components that interface with the JESD204B IP core to
demonstrate the following features:

• single or multiple link configuration
• different LMF settings with scrambling and internal serial loopback enabled
• interoperability against diverse converter devices
• dynamic reconfiguration

You can use the synthesizable design example entity in both simulation and hardware environments. Figure
5-1 illustrates the high level system architecture of the JESD204B IP core design example.
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Figure 5-1: Design Example Block Diagram
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The list below describes the mechanism of the design example architecture (with reference to the note
numbers in the design example block diagram).

1. For multiple links, the JESD204B IP core is instantiated multiple times. For example, in 2x112 (LMF)
configuration, two cores are instantiated, where each core is configured at LMF=112. (22)

2. The number of pattern generator or pattern checker instances is equivalent to the parameter value of
LINK. The data bus width per instance is equivalent to the value of FRAMECLK_DIV*M*S*N. (22)

3. The number of transport layer instances is equivalent to the parameter value of LINK. The legal value of
LINK is 1 and 2. The data buswidth per instance is equivalent to the value of FRAMECLK_DIV*M*S*N.(22)

The test_mode = 0 signal indicates a normal operation mode, where the assembler takes data from the
Avalon-ST source. Otherwise, the assembler takes data from the pattern generator.

4. The Avalon-ST interface data bus is fixed at 32-bit. The number of 32-bit data bus is equal to the number
of lanes (L).

5. The number of lanes per converter device (L).
6. You can enable internal serial loopback by setting the rx_seriallpbken input signal. You can dynamically

toggle this input signal. When toggled to 1, the RX path takes the serial input from the TX path internally
in the FPGA. When toggled to 0, the RX path takes the serial input from the external converter device.
During internal serial loopback mode, the assembler takes input from the pattern generator.

(22) Refer to Figure 5-17 and Figure 5-18 for the illustration of a single and multiple JESD204B links.
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7. A single serial port interface (SPI) master instance can control multiple SPI slaves. The SPI master is a
4-wire instance. If the SPI slave is a 3-wire instance, use a bidirectional I/O buffer in between the master
and slave to interface the 4-wire master to 3-wire slave.

8. The SPI protocol interface. All slaves share the same data lines (MISO and MOSI, or DATAIO). Each
slave has its own slave select or chip select line (SS_n).

9. The PLL takes the device clock from an external clock chip as the input reference. The PLL generates two
output clocks (utilizing two output counters from a single VCO). Clock 1 is the frame clock for the
transport layer, pattern generator, and pattern checker. Clock 2 is the link clock for the transport and
link layer.

10. The control unit implements a memory initialization file (MIF) method for configuring the SPI. Each
MIF corresponds to a separate external converter per device or clock chip. For example, in a system that
interacts with both DAC and ADC, two MIFs are needed—one each for DAC and ADC.

11. The PLL reconfiguration and transceiver reconfiguration controller instances are only required for run
time reconfiguration of the data rate.

Design Example Components
The design example for the JESD204B IP core consists of the following components:

• PLL
• PLL reconfiguration
• Transceiver reconfiguration controller
• Transceiver reset controller
• Pattern generator
• Pattern checker
• Assembler and deassembler (in the transport layer)
• SPI
• Control unit

The following sections describe in detail the function of each component.

PLL
The design example requires four different clock domains—device clock, management clock, frame clock,
and link clock.

Typically, the device clock is generated from an external converter or a clock device while the management
clock (AVS clock) is generated from an on-board 100 MHz oscillator.

For instance, if the JESD204B IP core is configured at data rate of 6.144 Gbps, transceiver reference clock
frequency of 153.6 MHz, and number of octets per frame (F) = 2, the example below indicates the PLL clock
frequencies:

• device clock = transceiver reference clock frequency = 153.6 MHz
• link clock = 6144 / 40 = 153.6 MHz
• frame clock = 153.6 x 32 / (8 x 2) = 307.2 MHz

Related Information

• Clocking Scheme on page 4-17
More information about the JESD204B IP core clocks.
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PLL Reconfiguration

The PLL reconfiguration utilizes theALTERA_PLL_RECONFIG IP core to implement reconfiguration logic
to facilitate dynamic real-time reconfiguration of PLLs in Altera devices. You can use the megafunction to
update the output clock frequency, PLL bandwidth, and phase shifts in real time, without reconfiguring the
entire FPGA.

In the design example, MIF approach is used to reconfigure the core PLL. The ALTERA_PLL_RECONFIG
IP core has two parameter options—"Enable MIF Streaming" and Path to MIF file—for MIF input. Enable
the MIF Streaming option and set core_pll.mif as the value to Path to MIF file parameter.

The following PLL reconfiguration Avalon-MM operations are involved during data rate reconfiguration.

Table 5-1: PLL Reconfiguration Operation

ValueBitByte Address
Offset (6bits)

Avalon-MM
Interface Signal

Operation

Arria V and Stratix V Devices

0x000 (maximumconfiguration)
or

0x02E (downscale configura-
tion)

[8:0]0x01Fpll_mgmt_*Set MIF base address

0x01[0:0]0x02pll_mgmt_*Write to the START register to
begin

Arria 10 Devices

0x000 (maximumconfiguration)
or

0x02E (downscale configura-
tion) (23)

[31:0]0x010pll_mgmt_*Start MIF streaming with MIF
base address specified in data
value

Related Information
AN 661: Implementing Fractional PLL Reconfiguration with Altera PLL and Altera PLL Reconfig
Megafunctions
More information on MIF streaming option.

Transceiver Reconfiguration Controller

The transceiver reconfiguration controller allows you to change the device transceiver settings at any time.
Any portion of the transceiver can be selectively reconfigured. Each portion of the reconfiguration requires
a read-modify-write operation (read first, then write), in such a way that it modifies only the appropriate
bits in a register and not changing other bits.

In the design example, MIF approach is used to reconfigure the ATX PLL and transceiver channel in the
JESD204 IP core via the Transceiver Reconfiguration Controller. The number of reconfiguration interface
is determined by number of lanes (L) + number of TX_PLL (different number of TX_PLL for bonded and

(23) The MIF base address is 9 bits (LSB). The remaining bits are reserved.
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non-bonded mode). Since the MIF approach reconfiguration for transceiver only supports non-bonded
mode, the number of TX_PLL is equal to number of lanes. The number of reconfiguration interface = 2 x
number of lanes (L).

The transceiver reconfiguration controller interfaces:

• MIF Reconfiguration Avalon-MM master interface—connects to the MIF ROM.
• Transceiver Reconfiguration interface—connects to the JESD204B IP core, which eventually connects

to the native PHY.
• Reconfiguration Management Avalon-MM slave interface—connects to the control unit.

The transceiver reconfiguration controller is only used in Arria V and Stratix V devices. For Arria
10 devices, the control unit directly communicates with the transceiver in the JESD204B IP core
through the reconfig_avmm_* interface signals.

Note:

The following transceiver reconfiguration controller Avalon-MM operations are involved during data rate
reconfiguration.

Table 5-2: Transceiver Reconfiguration Controller Operation for Arria V and Stratix V Devices

ValueBitByte Address
Offset (6bits)

Avalon-MM
Interface Signal

Operation

0[9:0]0x38reconfig_mgmt_*Write logical channel number

2'b00[3:2]0x3Areconfig_mgmt_*Write MIF mode

0[15:0]0x3Breconfig_mgmt_*Write 0 to streamer offset register

*32'h1000[31:0]0X3Creconfig_mgmt_*Write MIF base address to streamer
data register

1'b1[0]0x3Areconfig_mgmt_*Initiate a write of all the above data

1[15:0]0x3Breconfig_mgmt_*Write 1 to streamer offset register

3[31:0]0x3Creconfig_mgmt_*Write to streamer data register to set up
MIF streaming

1'b1[0]0x3Areconfig_mgmt_*Initiate a write of all the above data to
start streaming the MIF

1: Busy

0: Operation
completed

[8]0x3Areconfig_mgmt_*Read the busy bit to determine when
the write has completed

The above steps are repeated for the number of channels and followed by the number of TX_PLLs.Note:

For Arria 10 devices, the only Avalon-MM operation is a direct write to the transceiver register through the
reconfig_avmm_* interface at the JESD204B IP core. Every line in the MIF is DPRIO_ADDR[25:16]+
BIT_MASK[15:8]+ DATA[7:0]. The control unitmaps theDPRIO_ADDR to reconfig_avmm_address
and BIT_MASK '&' DATA to reconfig_avmm_data.
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Related Information
Altera Transceiver PHY IP Core User Guide
More information about the transceiver reconfiguration controller.

Transceiver Reset Controller

The transceiver reset controller uses the Altera's Transceiver PHY Reset Controller IP Core to ensure a
reliable initialization of the transceiver. The reset controller has separate reset controls per channel to handle
synchronization of reset inputs, hysteresis of PLL locked status, and automatic or manual reset recovery
mode.

In this design example, the reset controller targets both the TX and RX channels. The TX PLL, TXChannel,
and RX Channel parameters are programmable to accommodate single and multiple (2) JESD204B links.

Related Information

• Altera Transceiver PHY IP Core User Guide
More information about the Transceiver PHY Reset Controller IP Core.

• Arria V Device Handbook, Volume 2: Transceivers
More information about the device usage mode.

Pattern Generator
The pattern generator instantiates any supported generators and has an output multiplexer to select which
generated pattern to forward to the transport layer based on the test mode during run time. Additionally,
the pattern generator also supports run-time reconfiguration (downscale) on the number of converters per
device (M) & samples per converter per frame (S).

The pattern generator can be a parallel PRBS, alternate checkerboard, or ramp wave generator. The data
output bus width of the pattern generator is equivalent to the value of FRAMECLK_DIV × M × S × N.

The pattern generator includes a REVERSE_DATA parameter to control data arrangement at the output.
The default value of this parameter is 0.

• 0—no data rearrangement at the output of the generator.
• 1—data rearrangement at the output of the generator.

For example, when M=2, S=1, N=16, F1/F2_FRAMECLK_DIV=1, the input or output data width equals to
[31:0], with the following data arrangement:

0: {m1s0[31:16], m0s0[15:0]}
1: {m0s0[31:16], m1s0[15:0]}

Parallel PRBS Generator

PRBS generator circuits often consists of simple shift registers with feedback that serve as test sources for
serial data links. The output sequence is not truly random but repeats after 2X–1 bits, where X denotes the
length of the shift register. Polynomial notation—which the polynomial order corresponds to the length of
the shift register and the period of PRBS—provides a method of describing the sequence.

Alternate Checkerboard Generator

The alternate checkerboard generator circuit consists of simple flip registers that serve as test sources for
serial data links.
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The output sequence of subsequent N-bits sample is generated by inverting the previous N-bits (counting
from LSB to MSB) of the same data pattern at that clock cycle. The first N-bits sample from LSB of the data
pattern on next clock cycle is generated by inverting the last N-bits sample on the MSB of the data pattern
on current clock cycle.

Ramp Wave Generator

The ramp wave generator circuit consists of a simple register and adders that serve as test sources for serial
data links.

The output sequence of subsequent N-bits sample is an increment by one of the previous N-bits sample
(counting from LSB to MSB) in the same data pattern at that clock cycle. The first N-bits sample from LSB
of the data pattern on next clock cycle is generated by an increment by one of the last N-bits sample on the
MSB of the data pattern on current clock cycle.

Pattern Checker
The pattern checker instantiates any supported checkers and support run time reconfiguration (downscale)
of the number of converters per device (M) and samples per converter per frame (S).

The pattern checker can be either a parallel PRBS checker, alternate checkerboard checker, or ramp wave
checker. The data input bus width of the pattern checker is equivalent to the value of FRAMECLK_DIV ×
M × S × N.

The pattern checker includes an ERR_THRESHOLD parameter to control the number of error tolerance
allowed in the checker. The default value of this parameter is 1.

The pattern checker also includes a REVERSE_DATA parameter to control data arrangement at the input.
The default value of this parameter is 0.

• 0—no data rearrangement at the input of the checker.
• 1—data rearrangement at the input of the checker.

Parallel PRBS Checker

The PRBS checker contains the same polynomial as in the PRBS generator. The polynomial is only updated
when the enable signal is active, which indicates that the input data is valid. The feedback path is XOR'ed
with the input data to do a comparison. The checker flags an error when it finds any singlemismatch between
polynomial data and input data.

Alternate Checkerboard Checker

The alternate checkerboard checker is implemented in the same way as in the alternate checkerboard
generator. To do a comparison, an initial seed internally generates a set of expected data pattern result to
XOR'ed with the input data. The seed is updated only when the enable signal is active, which indicates that
the input data is valid. The checker flags an error when it finds any single mismatch between the expected
data and input data.

Ramp Wave Checker

The ramp wave checker is implemented in the same way as in the ramp wave generator. To do a comparison,
an initial seed internally generates a set of expected data pattern result to XOR'ed with the input data. The
seed is updated only when the enable signal is active, which indicates that the input data is valid. The checker
flags an error when it finds any single mismatch between the expected data and input data.
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Transport Layer
The transport layer in the JESD204B IP core consists of an assembler at the TX path and a deassembler at
the RX path.

The transport layer provides the following services to the application layer (AL) and the DLL:

• The assembler at the TX path:

• maps the conversion samples from the AL (through the Avalon-ST interface) to a specific format of
non-scrambled octets, before streaming them to the DLL.

• reports AL error to the DLL if it encounters a specific error condition on the Avalon-ST interface
during TX data streaming.

• The deassembler at the RX path:

• maps the descrambled octets from the DLL to a specific conversion sample format before streaming
them to the AL (through the Avalon-ST interface).

• reports AL error to the DLL if it encounters a specific error condition on the Avalon-ST interface
during RX data streaming.

Supported System Configuration

The transport layer supports static configurationswhere before compilation, you canmodify the configurations
using the IP core's parameter editor in the Quartus II software. To change to another configuration, you
have to recompile the design. The following list describes the supported configurations for the transport
layer:

• Data rate (maximum) = 12.5 Gbps (F1_FRAMECLK_DIV = 4 and F2_FRAMECLK_DIV = 2)
• L = 1–8
• F = 1, 2, 4, 8
• N = 12, 13, 14, 15, 16
• N' = 16
• CS = 0–3
• CF = 0
• HD = 0

Dynamic Downscaling Of System Parameters (L, N, and F)
The Dynamic Downscaling of System Parameters (DDSP) feature enables you to dynamically downscale
specific JESD204B system parameters through the CSR, without having to recompile the FPGA.

The transport layer supports dynamic downscaling of parameters L, F, and N only. The supported M and S
parameters are determined by the L, F, and N' parameters. Some parameters (for example, CS and N') do
not have this capability in the transport layer. If you needs to change any of these parameters, you must
recompile the system.

You are advised to connect the power down channels to higher indexes and connect used channel at lower
lanes. Otherwise, you have to reroute the physical-used channels to lower lanes externally when connecting
the IP core to the transport layer. For example, when L = 4 and csr_l = 8'd1 (which means two lanes out of
four lanes are active), with lane 1 and lane 3 being powered down, connection from theMAC to the transport
layer for lane 0 remains. However, lane 1 is powered down while lane 2 is not powered down. Thus, lane 2
output from the MAC should be rerouted to lane 1 data input of the transport layer. The data port for those
power-down channels will be tied off within the transport layer.
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The 16-bit N' data for F = 1 is formed through the data from 2 lanes. Thus, F = 1 is not supported for odd
number of lanes, for example, when LMF = 128. In this case, you can only reconfigure from F = 8 to F = 4
and F = 2 but not F = 1.

Relationship Between Frame Clock and Link Clock
The frame clock and link clock are synchronous.

The ratio of link_clk period to frame_clk period is given by this formula:

32 x L / M x S x N'

Table 5-7: txframe_clk and rxframe_clk Frequency for Different F Parameter Settings

For a given ftxlink (txlink_clk frequency) and frxlink (rxlink_clk frequency), the ftxframe (txframe_clk frequency) and
frxframe (rxframe_clk frequency) are derived from the formula listed in this table.

frxframe (rxframe_clk frequency)ftxframe (txframe_clk frequency)F Parameter

frxlink x (4 / F1_FRAMECLK_DIV )ftxlink x (4 / F1_FRAMECLK_DIV )1

frxlink x (2 / F2_FRAMECLK_DIV )ftxlink x (2 / F2_FRAMECLK_DIV )2

frxlinkftxlink4

frxlink / 2ftxlink / 28

Data Bit and Content Mapping Scheme
One major function of the transport layer is to arrange the data bits in a specific way between the Avalon-ST
interface and the DLL in the JESD204B IP core.

Figure 5-2 shows the mapping scheme in the transport layer across various TX to RX interfaces for a specific
system configuration.
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Figure 5-2: Mapping of Data Bit and Content Across Various Interfaces (LMF = 112, N = 12, N' = 16, S = 1,
T represents the tail bits).

01234567891011

[0]

[0]

[1][2][3][4][5][6][7][8][9][10][11]

[0][1][2][3][4][5][6][7][8][9][10][11]

[0][1][2][3][4][5][6][7][8][9][10][11][0][1][2][3][4][5][6][7][8][9][10][11] TTT TTT

1213141516171819202122232425262728293031

2nd jesd204_tx_datain[11:0]
(Avalon-ST interface to Transport Layer)

2nd jesd204_tx_ctrlin[0]
(Avalon-ST interface to Transport Layer)

[0]

[0]

[0]

[0]

[0]

1st jesd204_tx_ctrlin[0]
(Avalon-ST interface to Transport Layer)

[0]1st jesd204_rx_ctrlout[0]
(Transport Layer to Avalon-ST Interface)

[0]2nd jesd204_rx_ctrlout[0]
(Transport Layer to Avalon-ST Interface)

[0][1][2][3][4][5][6][7][8][9][10][11]2nd jesd204_rx_dataout[11:0]
(Transport Layer to Avalon-ST Interface)

1st jesd204_tx_datain[11:0]
(Avalon-ST interface to Transport Layer)

[0][1][2][3][4][5][6][7][8][9][10][11]1st jesd204_rx_dataout[11:0]
(Transport Layer to Avalon-ST Interface)

Bit Position

TX to RX Channel

jesd204_tx_link_datain[31:0]
(Transport Layer to Data Link Layer)

[0][1][2][3][4][5][6][7][8][9][10][11][0][1][2][3][4][5][6][7][8][9][10][11] TTT TTTjesd204_rx_link_datain[31:0]
(Data Link Layer to Transport Layer)

TX Path
The assembler in the TX path consists of the tail bits dropping, assembling, and multiplexing blocks.
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Figure 5-3: TX Path Assembler Block Diagram

Tail Bits
Padding Assembling Multiplexing

TX Control

jesd204_tx_link_datain[(L*32)-1:0]

Configuration Register Settings

jesd204_tx_link_early_ready

jesd204_tx_link_data_valid

jesd204_tx_link_error

txframe_clk
txframe_rst_n
txlink_clk
txlink_rst_n

Control Unit

JESD204B IP Core
Data Link LayerData

Bus
Data
Bus

Data
Bus

Data
Bus

jesd204_tx_datain
[DATA_BUS_WIDTH-1:0]
(1)

JESD204B Transport Layer TX Block

Interface with
Avalon-ST

jesd204_tx_data_valid
jesd204_tx_data_ready

Interfaces with JESD204 IP Core
Data Link Layer and Control Unit

Parameter L, M, F, N, N’,S,
F1_FRAMECLK_DIV,
F2_FRAMECLK_DIV

Note:
1. The DATA_BUS_WIDTH value is the data input bus width size, which depends on the F and L parameter.

bus_width=M*S*N
F=(M*S*N_PRIME)/(8*L)
M*S=(8*F*L)/N_PRIME

bus_width=(8*F*L*N)/N_PRIME

• Tail bits padding block—pads incoming data (jesd204_tx_datain) with "0" ifN < 16, so that the padded
data is 16 bits per sample.

• Assembling block—arranges the resulting data bits in a specific way according to the mapping scheme
(refer to Figure 5-2).

• Multiplexing block—sends the multiplexed data to the DLL interface, determined by certain control
signals from the TX control block.

Table 5-8: Assembler Parameter Settings

ValueDescriptionParameter

1–8Number of lanes per converter device.L

1, 2, 4. 8Number of octets per frame.F

0–3Number of control bits or conversion sample.CS

12-16Number of conversion bits per converter.N

16Number of transmitted bits per sample in the user data format.N'

Altera CorporationJESD204B IP Core Design Guidelines

Send Feedback

5-11TX Path
UG-01142
2014.06.30

mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20JESD204B%20IP%20Core%20Design%20Guidelines%20(UG-01142%202014.06.30)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


ValueDescriptionParameter

1, 4Only applies to cases where F=1.

The divider ratio on the frame_clk. The assembler always uses the post-
divided frame_clk (txframe_clk). (24)

F1_FRAMECLK_
DIV

1, 2Only applies to cases where F=2.

The divider ratio on the frame_clk. The assembler always uses the post-
divided frame_clk (txframe_clk). (24)

F2_FRAMECLK_
DIV

0, 1Enable reconfiguration support in the transport layer. Only downscaling
reconfiguration is supported. Disable the reconfiguration to reduce the
logic.

RECONFIG_EN

(8*F*L*N)/
N_PRIME

The data input bus width size that depends on the F and L.

bus_width = M*S*N

F = (M*S*N_PRIME)/(8*L)

M*S = (8*F*L)/N_PRIME

Therefore the data bus width = (8*F*L*N)/N_PRIME

DATA_BUS_
WIDTH

Table 5-9: Assembler Signals

DescriptionDirectionClock DomainSignalInterface

TX link clock signal. This clock is equal to
the TX data rate divided by 40. This clock is
synchronous to the txframe_clk signal.

Input—txlink_clk

Control
Unit

TX frame clock used by the transport layer.
The frequency is a function of parameters F,
F1_FRAMECLK_DIV,F2_FRAMECLK_DIV
and txlink_clk.

This clock is synchronous to the txlink_clk
signal.

Input—txframe_clk

Reset for the TX link clock domain logic in
the assembler. This reset is an active low
signal and the deassertion is synchronous to
the rising-edge of txlink_clk.

Inputtxlink_clktxlink_rst_n

Reset for the TX frame clock domain logic
in the assembler. This reset is an active low
signal and the deassertion is synchronous to
the rising-edge of txframe_clk.

Inputtxframe_clktxframe_rst_n

(24) Refer to theTable 5-7 to set the desired frame clock frequency with different FRAMECLK_DIV and F values.
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DescriptionDirectionClock DomainSignalInterface

TX data from the Avalon-ST source
interface. The source shall arrange the data
in a specific order, as illustrated in the cases
listed in TX Path Data Remapping section

Inputtxframe_clkjesd204_tx_

datain[(DATA_BUS_

WIDTH)-1:0]

Between
Avalon-
ST and
Transport
Layer

Indicates whether the data from theAvalon-
ST source interface to the transport layer is
valid or invalid.

• 0—data is invalid
• 1—data is valid

Inputtxframe_clkjesd204_tx_data_valid

Indicates that the transport layer is ready to
accept data from the Avalon-ST source
interface.

• 0—transport layer is not ready to receive
data

• 1—transport layer is ready to receive data

Outputtxlink_clkjesd204_tx_data_ready

Indicates transmitted data from the transport
layer to the DLL at txlink_clk clock rate,
where four octets are packed into a 32-bit
data width per lane. The data format is big
endian. The table below illustrates the data
mapping for L = 4:

Lanejesd204_tx_link_datain [x:y]

0[31:0]

1[63:32]

2[95:64]

3[127:96]

Connect this signal to the TXDLL jesd204_

tx_link_data[] input pin.

Outputtxlink_clkjesd204_tx_link_

datain[(L*32)-1:0]

Between
Transport
Layer
and DLL

Altera CorporationJESD204B IP Core Design Guidelines

Send Feedback

5-13TX Path
UG-01142
2014.06.30

mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20JESD204B%20IP%20Core%20Design%20Guidelines%20(UG-01142%202014.06.30)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.


DescriptionDirectionClock DomainSignalInterface

Indicates whether the jesd204_tx_link_
datain[] is valid or invalid.

• 0—jesd204_tx_link_datain[] is
invalid

• 1—jesd204_tx_link_datain[] is valid

Connect this signal to the TXDLL jesd204_

tx_link_valid input pin.

Outputtxlink_clkjesd204_tx_link_data_

valid

Between
Transport
Layer
and DLL

Indicates that the DLL requires valid data at
the subsequent implementation-specific
duration.

Connect this signal to the TXDLL jesd204_

tx_frame_ready output pin.

Inputtxlink_clkjesd204_tx_link_

early_ready
(25)

Indicates that the DLL is ready to accept
data.

• 0—link is not ready to sample jesd204_
tx_link_datain[]

• 1—link starts sampling jesd204_tx_
link_datain[]

Connect this signal to the TXDLL jesd204_

tx_link_ready output pin.

Inputtxlink_clkjesd204_tx_link_data_

ready

Indicates an error at the Avalon-ST source
interface. Specifically, this signal is asserted
when jesd204_tx_data_valid = "0" while
jesd204_tx_data_ready = "1". The DLL
subsequently reports this error to the CSR
block.

Connect this signal to the TXDLL jesd204_

tx_frame_error input pin.

Outputtxlink_clkjesd204_tx_link_error

(25) If a JESD device of No Multiple-Converter Device Alignment, Single-Lane (NMCDA-SL) class is deployed,
you are recommended to tie this input signal to "1".
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DescriptionDirectionClock DomainSignalInterface

Indicates the number of active lanes for the
link. This 5-bit bus represents the L value in
zero-based binary format. For example, if L
= 1, the csr_l[4:0] = "00000". This design
example supports the following values:

• 00000
• 00001
• 00011
• 00111

Any programmed value beyond the
supported range may result in undeter-
minable behavior in the transport layer. You
must ensure that the csr_l[4:0] value
alwaysmatches the systemparameterL value
when it is in static configuration.

Runtime reconfiguration supports L fallback.
For static configuration, set the maximum
L and reconfigure csr_l[] to a smaller value
during runtime. This transport layer only
supports higher index channels to be
powered down. To interleave the de-
commision channels, you need to modify
the interface connection from the DLL to
transport layer.

Connect this signal to the TX DLL csr_l[]

output pin.

Inputmgmt_clkcsr_l[4:0]
(26)

CSR in
the DLL

Indicates the number of octets per frame.
This 8-bit bus represents the F value in zero-

Inputmgmt_clkcsr_f[7:0]
(26)

based binary format. For example, if F = 2,
the csr_f[7:0] = "00000001". This design
example supports the following values:

• 00000000
• 00000001
• 00000011
• 00000111

Any programmed value beyond the
supported range may result in undeter-
minable behavior in the transport layer.
Ensure that the csr_f[7:0] value always
matches the system parameter F value when
it is in static configuration. Connect this
signal to the TX DLL csr_f[] output pin.
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DescriptionDirectionClock DomainSignalInterface

Indicates the converter resolution. This 5-bit
bus represents the N value in zero-based
binary format. For example, if N = 16, the
csr_n[4:0]= "01111". This design example
supports the following values:

• 01011
• 01100
• 01101
• 01110
• 01111

Any programmed value beyond the
supported range may result in undeter-
minable behavior in the transport layer. You
must ensure that the csr_n[4:0] value
alwaysmatch the systemparameterN value.

Connect this signal to the TX DLL csr_n[]

output pin.

Inputmgmt_clkcsr_n[4:0]
(26)CSR in

the DLL

TX Path Operation

The data transfer protocol between the Avalon-ST interface and the TX path transport layer is data transfer
with backpressure, where ready_latency = 0.Figure 5-4 shows the data transmission for a system configuration
of LMF = 112, N = N' = 16, S = 1.

(26) This signal should be static and valid before the deassertion of the link_rst_n and frame_rst_n signals.
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Figure 5-4: TX Operation Behavior

Operation:

• Upon the deassertion of the txframe_rst_n signal, the jesd204_tx_link_early_ready signal from the
DLL to the transport layer is asserted some time later, which activates the transport layer to start sampling
the jesd204_tx_datain[15:0] signal from the Avalon-ST interface.

• Each sampled 16-bit data is first written in a FIFO with a depth of four.
• Once the FIFO accumulates 32-bit data, the data is streamed to the DLL accordingly through the

jesd204_tx_link_datain[31:0] signal.
• Finally, the jesd204_tx_link_early_ready and jesd204_tx_data_ready signals deassert because the

DLL has entered code group synchronization state in this scenario.

txframe_clk

txlink_clk

txframe_rst_n/txlink_rst_n

jesd204_tx_data_valid
jesd204_tx_link_early_ready/

jesd204_tx_data_ready

jesd204_tx_datain[15:0]

jesd204_tx_link_data_valid

jesd204_tx_link_datain[31:0]

junk

All 0s

d0[15:0] d1[15:0] d2[15:0] d3[15:0] d4[15:0] d5[15:0] d6[15:0] d7[15:0] d8[15:0] d9[15:0] d10[15:0]

d0[15:0]
d1[15:0]

d2[15:0]
d3[15:0]

d4[15:0]
d5[15:0]

d6[15:0]
d7[15:0]

d8[15:0]
d9[15:0] All 0s

TX Data Transmission
This section explains the data transmission behavior when there is a valid TX data out from the TL to DLL.

Upon the deassertion of txframe_rst_n signal, the link's jesd204_tx_link_early_ready signal equals to
"1". This setting activates the TL to start sampling jesd204_tx_datain signal from the Avalon-ST interface
and transmits sampled data (jesd204_tx_link_datain) to the TX link. The TX link only captures valid
data from the TL when the jesd204_tx_link_ready signal equals to "1" (in user data phase). This means
all the data transmitted from the TL before jesd204_tx_link_ready signal equals to "1" are ignored.
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Figure 5-5: TX Data Transmission

Junk datain Valid Data

Junk Sampled Data Valid Data

txframe_clk
txlink_clk

txframe_rst_n
txlink_rst_n

jesd204_tx_datavalid

TL.jesd204_tx_link_early_ready

jesd204_tx_datain[15:0]

LINK.jesd204_tx_link_ready

jesd204_tx_link_datain[31:0]

Figure 5-6: TX Data Transmission (For F = 8)

Junk datain Valid Data

Junk Sampled Data Valid Data

txlink_clk

txframe_rst_n
txlink_rst_n

jesd204_tx_datavalid

jesd204_tx_link_early_ready

jesd204_tx_datain[63:0]

LINK.jesd204_tx_link_ready

jesd204_tx_link_datain[31:0]

txframe_clk

T0 -->T1

When F = 8, the data latency for jesd204_tx_link_datain should always
be in an even latency link_clk count to ensure that the first valid data captured
by the TX link is T0 data followed by T1 data.

TX Path Data Remapping
The JESD204B IP core implements the data transfer in big endian format.

The data is arranged so that the L0 is always on the right (LSB) in the data bus. In the big endian
implementation, the oldest data (F0) is placed at the MSB in L0.
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Table 5-10: Data Mapping for F=1, L=4

F = 1

M*S=2 for F=1, L=4

F=1 supports either (case1: M=1, S=2) or (case2: M=2, S=1)

SupportedMand
S

M0S0=F0F4, M0S1=F8F12, at 1st frameclkCase1: M=1, S=2{F8F12, F0F4} =
jesd204_tx_
datain[31:0]

F1_FRAMCLK_
DIV=1

M0S0=F0F4, M1S0=F8F12, at 1st frameclkCase2: M=2, S=1

M0S0=F1F5, M0S1=F9F13, at 2nd frameclkCase1: M=1, S=2{F9F13, F1F5} =
jesd204_tx_
datain[31:0] M0S0=F1F5, M1S0=F9F13, at 2nd frameclkCase2: M=2, S=1

M0S0=F2F6, M0S1=F10F14, at 3rd frameclkCase1: M=1, S=2{F10F114, F2F6} =
jesd204_tx_
datain[31:0] M0S0=F2F6, M1S0=F10F14, at 3rd frameclkCase2: M=2, S=1

M0S0=F3F7, M0S1=F11F15, at 4th frameclkCase1: M=1, S=2{F11F15, F3F7} =
jesd204_tx_
datain[31:0] M0S0=F3F7, M1S0=F11F15, at 4th frameclkCase2: M=2, S=1

{{F11F15, F3F7},{F10F114, F2F6},{F9F13, F1F5},{F8F12, F0F4}} = jesd204_tx_datain[127:0]F1_FRAMCLK_
DIV=4

L0L1L2L3Lane

{F0, F1, F2, F3}{F4, F5, F6, F7}{F8, F9, F10, F11}{F12, F13, F14, F15}Data Out

Table 5-11: Data Mapping for F=2, L=4

F = 2

M*S=4 for F=2, L=4

F=2 supports either (case1: M=1, S=4), (case2: M=2, S=2) or (case3: M=4, S=1)

SupportedMand
S
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F = 2

M0S0=F0F1, M0S1=F4F5, M0S2=F8F9,
M0S3=F12F13 at 1st frameclk

Case1: M=1, S=4

{F12F13,
F8F9,F4F5, F0F1}=
jesd204_tx_
datain[63:0]

F2_FRAMCLK_
DIV=1

M0S0=F0F1, M0S1=F4F5, M1S0=F8F9,
M1S1=F12F13 at 1st frameclk

Case2: M=2, S=2

M0S0=F0F1, M1S0=F4F5, M2S0=F8F9,
M3S0=F12F13 at 1st frameclk

Case3: M=4, S=1

M0S0=F2F3, M0S1=F6F7, M0S2=F10F11,
M0S3=F14F15 at 2nd frameclk

Case1: M=1, S=4

{F14F15,
F10F11,F6F7,F2F3}
= jesd204_tx_
datain[63:0]

M0S0=F2F3, M0S1=F6F7, M1S0=F10F11,
M1S1=F14F15 at 2nd frameclk

Case2: M=2, S=2

M0S0=F2F3, M1S0=F6F7, M2S0=F10F11,
M3S0=F14F15 at 2nd frameclk

Case3: M=4, S=1

{{F14F15, F10F11,F6F7, F2F3}, {F12F13, F8F9,F4F5, F0F1}} = jesd204_tx_datain[127:0]F2_FRAMCLK_
DIV=2

L0L1L2L3Lane

{F0, F1, F2, F3}{F4, F5, F6, F7}{F8, F9, F10, F11}{F12, F13, F14, F15}Data Out

Table 5-12: Data Mapping for F=4, L=4

F = 4

M*S=8 for F=4, L=4

F=4 supports either (case1: M=1, S=8), (case2: M=2, S=4), (case3: M=4, S=2) or (case4:
M=8, S=1)

SupportedMand
S

{M0S7,M0S6,M0S5,M0S4,M0S3,M0S2,M0S1,
M0S0}

Case1: M=1, S=8

{F14F15,F12F13,
F10F11,
F8F9,F6F7,F4F5,
F2F3,F0F1} =
jesd204_tx_
datain[127:0]

F=4

{M1S3,M1S2,M1S1,M1S0,M0S3,M0S2,M0S1,
M0S0}

Case2: M=2, S=4

{M3S1,M3S0,M2S1,M2S0,M1S1,M1S0,M0S1,
M0S0}

Case3: M=4, S=2

{M7S0,M6S0,M5S0,M4S0,M3S0,M2S0,M1S0,
M0S0}

Case4: M=8, S=1

L0L1L2L3Lane

{F0, F1, F2, F3}{F4, F5, F6, F7}{F8, F9, F10, F11}{F12, F13, F14, F15}Data Out
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Table 5-13: Data Mapping for F=8, L=4

F = 8

M*S=16 for F=8, L=4

F=8 supports either (case1: M=1, S=16), (case2: M=2, S=8), (case3: M=4, S=4), (case4:
M=8, S=2) or (case5: M=16, S=1)

SupportedMand
S

{M0S15, M0S14, M0S13, M0S12, M0S11,
M0S10, M0S9, M0S8, M0S7, M0S6, M0S5,
M0S4, M0S3, M0S2, M0S1, M0S0}

Case1: M=1, S=16{{F3031,
F28F29,F26F27,
F24F25}, {F22F23,
F20F21,F18F19,
F16F17}, {F14F15,
F12F13,F10F11,
F8F9}, {F6F7,F4F5,
F2F3,F0F1}} =
jesd204_tx_
datain[255:0]

F=8

L0L1L2L3Lane

{F0, F1, F2, F3}{F8, F9, F10, F11}{F16, F17, F18, F19}{F24, F25, F26, F27}Data Out at
linkclk T0

{F4, F5, F6, F7}{F12, F13, F14, F15}{F20, F21, F22, F23}{F28, F29, F30, F31}Data Out at
linkclk T1

TX Error Reporting

For TX path error reporting, the transport layer expects a valid stream of TX data from the Avalon-ST
interface (as indicated by the jesd204_tx_data_valid signal equal to "1") as long as the
jesd204_tx_data_ready remains asserted. If the jesd204_tx_data_valid signal unexpectedly deasserts
during this stage, the transport layer reports an error to the DLL by asserting the jesd204_tx_link_error
signal and deasserting the jesd204_tx_link_data_valid signal accordingly, as shown in the timing diagram
below.

Figure 5-7: TX Error Reporting

The jesd204_tx_data_valid signal deasserts for one frame_clk and cannot be sampled by the link_clk.

txframe_clk

txlink_clk

jesd204_tx_data_valid

jesd204_tx_data_ready

jesd204_tx_link_data_valid

jesd204_tx_link_error
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TX Latency

Table 5-14: TX Latency Associated with Different F and FRAMECLK_DIV Settings.

TX LatencyFRAMECLK_DIVF

3 txframe_clk period.

• Maximum 5 txframe_clk period for byte 3
• Minimum 2 txframe_clk period for byte 0

11

1 txframe_clk period41

3 txframe_clk period.

• Maximum 4 txframe_clk period for byte 2 and byte 3
• Minimum 3 txframe_clk period for byte 0 and byte 1

12

1 txframe_clk period22

1 txframe_clk period—4

1 txframe_clk period—8

RX Path
The deassembler in the RX path consists of the tail bits dropping, deassembling, and multiplexing blocks.

Figure 5-8: RX Path Assembler Block Diagram

Deassembling Multiplexing

RX Control

jesd204_rx_link_datain[(L*32)-1:0]
jesd204_rx_link_data_valid
jesd204_rx_linkdata_ready

jesd204_rx_linkerror
Configuration Register Settings

rxframe_clk
rxframe_rst_n

rxlink_clk
rxlink_rst_n

Control Unit

JESD204B IP Core
Data Link Layer Data

Bus
Data
Bus

Data
Bus

Data
Bus

jesd204_rx_dataout
[OUTPUT_BUS_WIDTH-1:0]

JESD204B Transport Layer RX Block

jesd204_rx_data_valid

jesd204_rx_data_ready

Interface with
Avalon-ST

Interfaces with JESD204B IP Core
Data Link Layer and Control Unit

Parameter L, M, F, N, N’,S,
F1_FRAMECLK_DIV,
F2_FRAMECLK_DIV

Tail Bits
Dropping

• Tail bit dropping block—drops padded tail bits in the incoming data (jesd204_rx_link_datain).
• Deassembling block—rearranges the resulting data bits in a specific way according to themapping scheme

(refer to Figure 5-2).
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• Multiplexing block—sends themultiplexed data to theAvalon-ST interface, determined by certain control
signals from the RX control block.

Table 5-15: Deassembler Parameter Settings

ValueDescriptionParameter

1–8Number of lanes per converter device.L

1, 2, 4, 8Number of octets per frame.F

0–3Number of control bits or conversion sample.CS

12-16Number of conversion bits per converter.N

16Number of transmitted bits per sample in the user data format.N'

1, 4Only applies to cases where F=1.

The divider ratio on the frame_clk. The deassembler always uses the
post-divided frame_clk (rxframe_clk). (27)

F1_FRAMECLK_DIV

1, 2Only applies to cases where F=2.

The divider ratio on the frame_clk. The deassembler always uses the
post-divided frame_clk (rxframe_clk). (27)

F2_FRAMECLK_DIV

0, 1Enable reconfiguration support in the transport layer. Only downscaling
reconfiguration is supported. Disable the reconfiguration to reduce the
logic.

RECONFIG_EN

(8*F*L*N)
/N_
PRIME

The data output bus width size that depends on the F and L.

bus_width = M*S*N

F = (M*S*N_PRIME)/(8*L)

M*S = (8*F*L)/N_PRIME

Therefore the output bus width = (8*F*L*N)/N_PRIME

OUTPUT_BUS_
WIDTH

(27) Refer to the Table 5-7 to set the desired frame clock frequency with different FRAMECLK_DIV and F
parameter values.
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Table 5-16: Deassembler Signals

DescriptionDirectionClock DomainSignalInterface

RX link clock signal. This clock is equal to
the RX data rate divided by 40. This clock is
synchronous to the rxframe_clk signal.

Input—rxlink_clk

Control
Unit

RX frame clock used by the deassembler. The
frequency is a function of parameters F, F1_
FRAMECLK_DIV, F2_FRAMECLK_DIV
and rxlink_clk.

This clock is synchronous to the rxlink_clk
signal.

Input—rxframe_clk

Reset for the RX link clock domain logic in
the deassembler. This reset is an active low
signal and the deassertion is synchronous to
the rising-edge of rxlink_clk.

Inputrxlink_clkrxlink_rst_n

Reset for the RX frame clock domain logic
in the deassembler. This reset is an active
low signal and the deassertion is
synchronous to the rising-edge of rxframe_
clk.

Inputrxframe_clkrxframe_rst_n

RX data to the Avalon-ST source interface.
The transport layer arranges the data in a
specific order, as illustrated in the cases listed
in RX Path Data Remapping section.

Outputrxframe_clkjesd204_rx_

dataout[(OUTPUT_BUS_

WIDTH)-1:0]

Between
Avalon-
ST and
Transport
Layer

Indicates whether the data from the
transport layer to the Avalon-ST sink
interface is valid or invalid.

• 0—data is invalid
• 1—data is valid

Outputrxframe_clkjesd204_rx_data_valid

Indicates that the Avalon-ST sink interface
is ready to accept data from the transport
layer.

• 0—Avalon-ST sink interface is not ready
to receive data

• 1—Avalon-ST sink interface is ready to
receive data

Inputrxframe_clkjesd204_rx_data_ready
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DescriptionDirectionClock DomainSignalInterface

Indicates received data from the DLL to the
transport layer, where four octets are packed
into a 32-bit data width per lane. The data
format is big endian. The table below
illustrates the data mapping for L = 4:

Lanejesd204_rx_link_datain [x:y]

0[31:0]

1[63:32]

2[95:64]

3[127:96]

Connect this signal to the RXDLL jesd204_

rx_link_data[] output pin.

Inputrxlink_clkjesd204_rx_link_

datain[(L*32)-1:0]

Between
Transport
Layer
and DLL

Indicates whether the jesd204_rx_link_
datain[] is valid or invalid.

• 0—jesd204_rx_link_datain[] is
invalid

• 1—jesd204_rx_link_datain[] is valid

Connect this signal to the RXDLL jesd204_

rx_link_valid output pin.

Inputrxlink_clkjesd204_rx_link_data_

valid

Between
Transport
Layer
and DLL

Indicates that the transport layer is ready to
sample jesd204_rx_link_datain[].

• 0—transport layer is not ready to sample
jesd204_rx_link_datain[]

• 1—transport layer starts sampling
jesd204_rx_link_datain[] at the next
clock cycle.

Connect this signal to the RXDLL jesd204_

rx_link_ready input pin.

Outputrxframe_clkjesd204_rx_link_data_

ready

Indicates an empty data stream due to
invalid data. This signal is asserted high to
indicate an error at the Avalon-ST sink
interface (for example, when jesd204_rx_

data_valid = "1" while jesd204_rx_data_
ready = "0"). The DLL subsequently reports
this error to the CSR block.

Connect this signal to the RXDLL jesd204_

rx_frame_error input pin.

Outputrxlink_clkjesd204_rx_link_error
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DescriptionDirectionClock DomainSignalInterface

Indicates the number of active lanes for the
link. This 5-bit bus represents the L value in
zero-based binary format. For example, if L
= 1, the csr_l[4:0] = "00000". This design
example supports the following values:

• 00000
• 00001
• 00011
• 00111

Any programmed value beyond the
supported range may result in undeter-
minable behavior in the transport layer. You
must ensure that the csr_l[4:0] value
always match the system parameter L value.

Runtime reconfiguration supports L fallback.
For static configuration, set the maximum
L and reconfigure csr_l[] to a smaller value
during runtime. This transport layer only
supports higher index channels to be
powered down. To interleave the de-
commision channels, you need to modify
the interface connection from the DLL to
transport layer.

Connect this signal to the RX DLLcsr_l[]
output pin.

Inputmgmt_clkcsr_l[4:0]
(28)

CSR in
DLL

Indicates the number of octets per frame.
This 8-bit bus represents the F value in zero-
based binary format. For example, if F = 2,
the csr_f[7:0] = "00000001". This design
example supports the following values:

• 00000000
• 00000001
• 00000011
• 00000111

Any programmed value beyond the
supported range may result in undeter-
minable behavior in the transport layer. You
must ensure that the csr_f[7:0] value
always match the system parameter F value.

Connect this signal to the RX DLL csr_f[]

output pin.

Inputmgmt_clkcsr_f[7:0]
(28)
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DescriptionDirectionClock DomainSignalInterface

Indicates the converter resolution. This 5-bit
bus represents the N value in zero-based
binary format. For example, if N = 16, the
csr_n[4:0]= "01111". This design example
supports the following values:

• 01011
• 01100
• 01101
• 01110
• 01111

Any programmed value beyond the
supported range may result in undeter-
minable behavior in the transport layer. You
must ensure that the csr_n[4:0] value
alwaysmatch the systemparameterN value.

Connect this signal to the RX DLL csr_n[]

output pin.

Inputmgmt_clkcsr_n[4:0]
(28)CSR in

DLL

RX Path Operation

The data transfer protocol between the Avalon-ST interface and the RX path transport layer is data transfer
without backpressure. Therefore, the sink shall always be ready to sample the incoming data whenever data
at the source is valid. Figure 5-9 shows the data transmission for a system configuration of LMF = 112, N
= 12, N' = 16, S =1.

(28) This signal should be static and valid before the deassertion of the link_rst_n and frame_rst_n signals.
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Figure 5-9: RX Operation Behavior

Operation:

• Upon the deassertion of the rxframe_rst_n signal, the jesd204_rx_link_data_ready signal from the
deassembler to the DLL is asserted at the next rxframe_clk.

• Subsequently, the DLL asserts the jesd204_rx_link_data_valid signal for the deassembler to activate
the f2_div1_cnt signal logic and to start sampling the jesd204_rx_link_datain[31:0] signal. (30)

• At the following rxframe_clk, the jesd204_rx_data_valid is asserted along with the multiplexed
jesd204_rx_dataout[11:0] signal to stream data to the Avalon-ST interface.

• Finally, the DLL deasserts the jesd204_rx_link_data_valid signal when there is no more valid data.
• The deassembler deactivates the f2_div1_cnt signal logic accordingly, and deasserts the

jesd204_rx_data_valid at the next rxframe_clk.

rxframe_clk

rxlink_clk

rxframe_rst_n

rxlink_rst_n

jesd204_rx_link_data_ready

jesd204_rx_link_data_valid

f2_div1_cnt

jesd204_rx_link_datain[31:0]

rxdata_mux_out[15:0]

jesd204_rx_crtlout[0]

jesd204_rx_data_valid

jesd204_rx_data_ready

junk xddcc bbaa

junk

junk

junk

xbbaa ddcc x4433 bbaa xddcc 4433

xddc xbba xbba xddc x443 xbba xddc x443

jesd204_rx_dataout[11:0] junk junkxddc xbba xbba xddc x443 xbba xddc x443

RX Data Reception
This section explains when there is a valid RX data out from the DLL to the TL to with scrambler enabled.

The MAC layer process the jesd204_rx_dataout signal once the TL asserts the jesd204_rx_data_valid
signal. However, there are some data that should be discarded by the upper layer when the you enable the
scrambler. This is because the initial unknown seed value within the scrambler can corrupt the very first
eight octets, which is the data for the first two link clock cycles. The data can be translated to the frame clock
cycle depending on the F and FRAMECLK_DIV parameters selected based on the frame clock to link clock
relationship.

(30) The f2_div1_cnt signal is internally generated in the RX control block to correctly stream data to the Avalon-
ST interface.
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Figure 5-11: RX Data Reception

Junk

Scrambler Corrupted Data

JunkValid Data

All 0s All 0sValid Data

rxframe_clk

rxlink_clk

rxframe_rst_n
rxlink_rst_n

jesd204_rx_link_datain[63:0]

jesd204_rx_link_data_valid

jesd204_rx_dataout[15:0]

jesd204_rx_data_valid

Related Information
Relationship Between Frame Clock and Link Clock on page 5-9

RX Path Data Remapping
The JESD204B IP core implements the data transfer in big endian format.

The data is arranged so that the L0 is always on the right (LSB) in the data bus. In the big endian
implementation, the oldest data (F0) is placed at the MSB in L0.

Table 5-17: Data Mapping for F=1, L=4

F = 1

L0L1L2L3Lane

{F0, F1, F2, F3}{F4, F5, F6, F7}{F8, F9, F10, F11}{F12, F13, F14, F15}Data In

M*S=2 for F=1, L=4

F=1 supports either (case1: M=1, S=2) or (case2: M=2, S=1)

Assuming N=16, M0S0=jesd204_rx_dataout[15:0], M0S1/M1S0= jesd204_rx_
dataout[31:16]

SupportedMand
S
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F = 1

M0S0=F0F4, M0S1=F8F12, at 1st frameclkCase1: M=1, S=2cnt=0 :

jesd204_rx_
dataout[31:0] =
{F8F12, F0F4}

F1_FRAMCLK_
DIV=1

M0S0=F0F4, M1S0=F8F12, at 1st frameclkCase2: M=2, S=1

M0S0=F1F5, M0S1=F9F13, at 2nd frameclkCase1: M=1, S=2cnt=1:

jesd204_rx_
dataout[31:0] =
{F9F13, F1F5}

M0S0=F1F5, M1S0=F9F13, at 2nd frameclkCase2: M=2, S=1

M0S0=F2F6, M0S1=F10F14, at 3rd frameclkCase1: M=1, S=2cnt=2:

jesd204_rx_
dataout[31:0] =
{F10F114, F2F6}

M0S0=F2F6, M1S0=F10F14, at 3rd frameclkCase2: M=2, S=1

M0S0=F3F7, M0S1=F11F15, at 4th frameclkCase1: M=1, S=2cnt=3:

jesd204_rx_
dataout[31:0] =
{F11F15, F3F7}

M0S0=F3F7, M1S0=F11F15, at 4th frameclkCase2: M=2, S=1

jesd204_rx_dataout[127:0] = {{F11F15, F3F7},{F10F114, F2F6},{F9F13, F1F5},{F8F12,
F0F4}}

F1_FRAMCLK_
DIV=4

Table 5-18: Data Mapping for F=2, L=4

F = 2

L0L1L2L3Lane

{F0, F1, F2, F3}{F4, F5, F6, F7}{F8, F9, F10, F11}{F12, F13, F14, F15}Data In

M*S=4 for F=2, L=4

F=2 supports either (case1: M=1, S=4), (case2: M=2, S=2) or (case3: M=4, S=1)

SupportedMand
S
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F = 2

M0S0=F0F1, M0S1=F4F5, M0S2=F8F9,
M0S3=F12F13 at 1st frameclk

Case1: M=1, S=4
cnt=0:

jesd204_rx_
dataout[63:0] =
{F12F13,
F8F9,F4F5, F0F1}

F2_FRAMCLK_
DIV=1

M0S0=F0F1, M0S1=F4F5, M1S0=F8F9,
M1S1=F12F13 at 1st frameclk

Case2: M=2, S=2

M0S0=F0F1, M1S0=F4F5, M2S0=F8F9,
M3S0=F12F13 at 1st frameclk

Case3: M=4, S=1

M0S0=F2F3, M0S1=F6F7, M0S2=F10F11,
M0S3=F14F15 at 2nd frameclk

Case1: M=1, S=4
cnt=1:

jesd204_rx_
dataout[63:0] =
{F14F15,
F10F11,F6F7,F2F3}

M0S0=F2F3, M0S1=F6F7, M1S0=F10F11,
M1S1=F14F15 at 2nd frameclk

Case2: M=2, S=2

M0S0=F2F3, M1S0=F6F7, M2S0=F10F11,
M3S0=F14F15 at 2nd frameclk

Case3: M=4, S=1

jesd204_rx_dataout[127:0] = {{F14F15, F10F11,F6F7, F2F3}, {F12F13, F8F9,F4F5, F0F1}}F2_FRAMCLK_
DIV=2

Table 5-19: Data Mapping for F=4, L=4

F = 4

L0L1L2L3Lane

{F0, F1, F2, F3}{F4, F5, F6, F7}{F8, F9, F10, F11}{F12, F13, F14, F15}Data In

M*S=8 for F=4, L=4

F=4 supports either (case1: M=1, S=8), (case2: M=2, S=4), (case3: M=4, S=2) or (case4:
M=8, S=1)

SupportedMand
S

{M0S7,M0S6,M0S5,M0S4,M0S3,M0S2,M0S1,
M0S0}

Case1: M=1, S=8

jesd204_rx_
dataout[127:0] =
{F14F15,
F12F13,F10F11,
F8F9,F6F7,F4F5,
F2F3,F0F1}

F=4

{M1S3,M1S2,M1S1,M1S0,M0S3,M0S2,M0S1,
M0S0}

Case2: M=2, S=4

{M3S1,M3S0,M2S1,M2S0,M1S1,M1S0,M0S1,
M0S0}

Case3: M=4, S=2

{M7S0,M6S0,M5S0,M4S0,M3S0,M2S0,M1S0,
M0S0}

Case4: M=8, S=1

Table 5-20: Data Mapping for F=8, L=4

F = 8

L0L1L2L3Lane

{F0, F1, F2, F3}{F8, F9, F10, F11}{F16, F17, F18, F19}{F24, F25, F26, F27}Data In linkclk
T0
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F = 8

{F4, F5, F6, F7}{F12, F13, F14, F15}{F20, F21, F22, F23}{F28, F29, F30, F31}Data In linkclk
T1

M*S=16 for F=8, L=4

F=8 supports either (case1: M=1, S=16), (case2: M=2, S=8), (case3: M=4, S=4), (case4:
M=8, S=2) or (case5: M=16, S=1)

SupportedMand
S

{M0S15, M0S14, M0S13, M0S12, M0S11,
M0S10, M0S9, M0S8, M0S7, M0S6, M0S5,
M0S4, M0S3, M0S2, M0S1, M0S0}

Case1: M=1, S=16jesd204_rx_
dataout[255:0] =
{{F3031,
F28F29,F26F27,
F24F25},{F22F23,
F20F21,F18F19,
F16F17},{F14F15,
F12F13,
F10F11,F8F9},
{F6F7,F4F5,
F2F3,F0F1}}

F=8

RX Error Reporting

For RX path error reporting, the transport layer expects the AL to always be ready to sample the RX data
(as indicated by the jesd204_rx_data_ready signal equal to "1") as long as the jesd204_rx_data_valid
remains asserted. If the jesd204_rx_data_ready signal unexpectedly deasserts, the transport layer reports
the error to the DLL by asserting the jesd204_rx_link_error signal, as shown in the timing diagram below.

Figure 5-12: RX Error Reporting

rxframe_clk

rxlink_clk

jesd204_rx_link_error

jesd204_rx_data_valid

jesd204_rx_data_ready

RX Latency

The RX latency is defined as the time needed to fully transfer a 32-bit data in a lane
(jesd204_rx_link_datain*) to the Avalon-ST interface (jesd204_rx_dataout*) when the
jesd204_rx_link_data_valid signal equals to "1".
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Table 5-21: RX Latency Associated with Different F and FRAMECLK_DIV Settings.

RX LatencyFRAMECLK_DIVF

• Maximum 5 rxframe_clk period for byte 3
• Minimum 2 rxframe_clk period for byte 0

11

2 rxframe_clk period41

• Maximum 3 rxframe_clk period for byte 2 and byte 3
• Minimum 2 rxframe_clk period for byte 0 and byte 1

12

2 txframe_clk period22

2 txframe_clk period—4

2 txframe_clk period—8

Serial Port Interface (SPI)

An external converter device with a SPI allows you to configure the converter for specific functions or
operations through a structured register space provided inside the converter device. The SPI gives flexibility
and customization, depending on the application. Addresses are accessed via the serial port and can be
written to or read from the port. The memory is organized into bytes that can be further divided into fields.

The SPI communicates using two data lines, a control line, and a synchronization clock. A single SPI master
can work with multiple slaves. The SPI core logic is synchronous to the clock input provided by the Avalon-
MM interface. When configured as a master, the core divides the Avalon-MM clock to generate the SCLK
output. Figure 5-13 shows the timing diagram of a 24-bit SPI transaction required by a typical external
converter device.

Figure 5-13: Serial Port Interface (24-bit) Timing Diagram

R/W W1 W0 A12 A11 A10 A9 A8 A7 D5 D4 D3 D2 D1 D0Don’t Care

Don’t Care Don’t Care

Don’t Care

SS_n

SCLK

SDIO

The first 16 bits are instruction data. The first bit in the stream is the read or write indicator bit. This bit
goes high to indicate a read request. W1 and W0 represent the number of data bytes to transfer for either a
read or write process. For implementation simplicity, W1 and W0 are always set at 0 in this design example.
The subsequent 13 bits represent the starting address of the data sent. The last 8 bits are register data.

For a 32-bit SPI transaction, each SPI programming cycle needs to be preceded with a preselection byte. The
preselection byte is typically used to forward the SPI command to the right destination. Figure 5-14 shows
the timing diagram of a 32-bit SPI transaction.
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Figure 5-14: Serial Port Interface (32-bit) Timing Diagram

A12 A11 A10 A9 A8 A7 A6 A5 A4 A3 A2 A1 A0 D7 D6 D5 D4 D3 D2 D1 D0P7 P6 P5 P4 P3 P2 P1 P0 R/W W1 W0

8 Bit Pre-Selection 8 Bit Register Data16 Bit Instruction

SS_n

SCLK

SDIO

In this design example, the SPI core is configured as a 4-wire master protocol to control three independent
SPI slaves—ADC, DAC, and clock devices. The width of the receive and transmit registers are configured
at 32 bits. Data is sent in MSB-first mode in compliance with the converter device default power up mode.
The SPI clock (sclk) rate is configured at a frequency of the SPI input clock rate divided by 5. If the SPI
input clock rate is 100 MHz (in the mgmt_clock domain), the sclk rate is 20 MHz. If the external converter
device's SPI interface is a 3-wire protocol without bothMOSI (master output, slave input) andMISO (master
input, slave output) lines but with a single DATAIO pin, you can use the ALTIOBUF Megafunction IP core
(configured with bidirectional buffer) with the SPI master to convert the MOSI and MISO lines to a single
DATAIO pin. The DATAIO pin can be dynamically reconfigured as MOSI by asserting the output enable
(oe) signal or as MISO by deasserting the oe signal. For implementation simplicity, you can directly connect
the master MOSI pin to the slave DATAIO pin if read transactions are not required.

Related Information
I/O Buffer (ALTIOBUF) Megafunction User Guide
More information about configuring the ALTIOBUF Megafunction IP Core.

Control Unit

The control unit has access to the CSR interface of the JESD204B IP core duplex base core, PLL reconfigura-
tion, transceiver reconfiguration controller, and SPI master. The control unit also serves as a clock and reset
unit (CRU) for the design example.

The control unit replaces the software-based Nios II processor to perform device configuration and initial-
ization on the JESD204B duplex base core. This configuration and initialization process includes the
transceivers, transport layer, pattern generator and checker, external converters (ADC/DAC), and clock
devices over the SPI interface.
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Figure 5-15: Control Unit Process Flow

Power-Up and Reset

Assert Transceiver
(user-triggered),

Frame, and CSR Reset

SPI Configuration

Assert Link, Frame, and
CSR Reset

Deassert Transceiver Reset

Deassert CSR Reset,
followed by Link and

Frame Reset

INIT Done

IDLE

Start Reconfiguration

Assert Link and
Frame Transceiver Reset

SPI Reconfiguration

LMF Reconfiguration

PLL Reconfiguration

Transceiver Reconfiguration

Deassert Transceiver Reset

Deassert Link and Frame
Reset

Reconfiguration Done

reconfig = 1’b1

Memory Block (ROM)
The control unit is a finite state machine (FSM) that works with multiple memory blocks (ROMs).

Each ROM holds the configuration data required to configure the external converter or clock devices for
each SPI slave. A memory initialization file (MIF) contains the initial values for each address in the memory.
Each memory block requires a separate file. The MIF can be created in the Quartus II software text editor
tool.
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Figure 5-16: Example of MIF Format and Content

-- MIF content for ADC

WIDTH=24; -- the size of data in bits
DEPTH=8; -- the size of memory in words
ADDRESS_RADIX=UNS; -- the radix for address values
DATA_RADIX=BIN; -- the radix for data values

CONTENT BEGIN
0 : 000000000101111100010101; -- write 0x15 to link control 1 register 0x5F to disable the lane
1 : 000000000101111001000100; -- write 0x44 to quick config register 0x5E for L=4, M=4
2 : 000000000110010011000000; -- write 0xC0 to DID register 0x64
3 : 000000000110111000000011; -- write 0x03 to parameter SCR/L register 0x6E to disable scrambler
4 : 000000000111000000001111; -- write 0x0F to parameter K register 0x70 for K=16 in base IP core
5 : 000000000000110100000100; -- write 0x04 to test mode register 0x0D for checkerboard test pattern
6 : 000000000101111100010100; -- write 0x14 to link control 1 register 0x5F to enable the lane
7 : 111111111111111111111111; -- indicates end of mif or end of programming sequence

END;

The initial values for each address and sequence is defined based on the requirement of the external converter
and clock devices. The example above is based on 24-bit SPI write-only programming.

The last wordmust not be a valid data andmust be set to all 1's to indicate the end of theMIF or programming
sequence. This is because each converter device may have a different number of programmable registers
and hence involves a different number ofMIFwords. In this design example, three ROMs are used by default
for each external ADC, DAC, and clock devices. If either one of the device is not used, a single word MIF
with all 1's can be created.

The MIFs in this design example is an example for a particular converter device. You must define
the MIF content based on the requirement of the external converter devices.

Note:

Finite State Machine (FSM)

The steps below describe the FSM flow:

1. Initialize the SPI:

a. Perform a read transaction from the ROM on per word basis and write to the SPI master for SPI write
transaction to the external SPI slave.

b. Perform a read transaction from the next ROM and perform the same SPI write transaction to next
SPI slave.

2. Initialize the JESD204B IP base core, transport layer, pattern generator, and pattern checker upon
successful initialization of the transceiver.

System Parameters
The table below lists the parameters exposed at the system level.
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Table 5-22: System Parameter Settings

DescriptionDefaultValue (31)Parameter

Number of JESD204B link. One link represent one JESD204B
instance.

11, 2LINK

Number of lanes per converter device.21, 2, 4, 8L

Number of converters per device.21, 2, 4, 8M

Number of octets per frame.21, 2, 4, 8F

Number of transmitted samples per converter per frame.11, 2S

Number of conversion bits per converter.1612–16N

Number of transmitted bits per sample in the user data format.1616N'

The divider ratio on frame_clk when F = 1. The transport layer
uses the post-divided frame_clk.

41, 4F1_FRAMECLK_
DIV

The divider ratio on frame_clk when F = 2. The transport layer
uses the post-divided frame_clk.

21, 2F2_FRAMECLK_
DIV

Defines the polynomial length for the PRBS pattern generator
and checker, which is also the equivalent number of stages for
the shift register.

• If PRBS-7 is required, set this parameter to 7.
• If PRBS-9 is required, set this parameter to 9.
• If PRBS-15 is required, set this parameter to 15.
• If PRBS-23 is required, set this parameter to 23.
• If PRBS-31 is required, set this parameter to 31.

This parameter value must not be larger than N, which is the
output data width of the PRBS pattern generator or converter
resolution. If an N of 12-14 is required, PRBS-7 and PRBS-9 are
the only feasible options. If an N of 15-16 is required, PRBS-7,
PRBS-9, and PRBS-15 are the only feasible options.

77, 9, 15, 23,
31

POLYNOMIAL_
LENGTH

Defines the feedback tap for the PRBS pattern generator and
checker. This is an intermediate stage that is XOR-ed with the
last stage to generate to next PRBS bit.

• If PRBS-7 is required, set this parameter to 6.
• If PRBS-9 is required, set this parameter to 5.
• If PRBS-15 is required, set this parameter to 14.
• If PRBS-23 is required, set this parameter to 18.
• If PRBS-31 is required, set this parameter to 28.

66, 5, 14, 18,
28

FEEDBACK_TAP

(31) Values supported or demonstrated by this design example.
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Table 5-22 lists the configuration that this design example supports. However, the design example generated
by the Qsys system is always fixed at a data rate of 6144 Mbps and a limited set of configuration as shown
in the table below. If your setting in the Qsys parameter editor does not match one of the LMF and bonded
mode parameter values inTable 5-23, the design example is generated with the default values of LMF = 124.

Table 5-23: Static and Dynamic Reconfiguration Parameter Values Supported

F2_FRAMECLK_
DIV

F1_
FRAMECLK_

DIV

Link
Clock

Frame
Clock

Reference
Clock

FMLLinkMode

Static

2153.6153.6153.62112Bonded/Non-bonded

1153.6153.6153.64111Bonded/Non-bonded

1153.6153.6153.64211Bonded/Non-bonded

1153.676.8153.68411Bonded/Non-bonded

4153.6153.6153.61121Bonded/Non-bonded

2153.6153.6153.62121Bonded/Non-bonded

1153.6153.6153.64121Bonded/Non-bonded

2153.6153.6153.62222Bonded/Non-bonded

1153.6153.6153.64221Bonded/Non-bonded

1153.6153.6153.64421Bonded/Non-bonded

4153.6153.6153.61241Bonded/Non-bonded

2153.6153.6153.62241Bonded/Non-bonded

2153.6153.6153.62441Bonded/Non-bonded

1153.6153.6153.64441Bonded/Non-bonded

1153.6153.6153.64841Bonded/Non-bonded

4153.6153.6307.21181Bonded/Non-bonded

4153.6153.6307.21281Bonded/Non-bonded

4153.6153.6307.21481Bonded/Non-bonded

2153.6153.6307.22481Bonded/Non-bonded

Dynamic Reconfiguration

2153.6153.6153.62222Non-bonded

The following figures show the datapath of single and multiple JESD204B links.
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Figure 5-17: Datapath of A Single JESD204B Link
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Figure 5-18: Datapath of Multiple JESD204B Links
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Run-Time Reconfiguration
The JESD204B IP core supports run-time reconfiguration for the LMF and data rate settings. The design
example only demonstrates the following set of configuration.

To generate the design example with run-time reconfiguration enabled, the LMF and bonding mode
parameters must match the default value listed in the table below.
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Table 5-24: Run-time Configuration Demonstrated By The Design Example

Run-time ConfigurationDefaultParameter

112222LMF

22FRAMECLK_DIV

3072 Mbps6144 MbpsData Rate

76.8 MHz153.6 MHzLink Clock

76.8 MHz153.6 MHzFrame Clock

Non-bondedNon-bondedBonding Mode

System Interface Signals

Table 5-25: Interface Signals

DescriptionDirectionClock
Domain

SignalInterface

Device clock signal from the external converter
or clock device.

Input—device_clk

Clocks
and
Resets

Management clock signal from the on-board
100 MHz oscillator.

Input—mgmt_clk

Internally generated clock. TheAvalon-ST user
data input must be synchronized to this clock
domain for normal operation mode.

Output—frame_clk

Global reset signal from the push button. This
reset is an active low signal and the deassertion
of this signal is synchronous to the rising-edge
of mgmt_clk.

Inputmgmt_

clk

global_rst_n
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DescriptionDirectionClock
Domain

SignalInterface

TX SYSREF signal for JESD204B Subclass 1
implementation.

Inputlink_

clk

tx_sysref[LINK-1:0]

JESD204B

Indicates a TX SYNC_N from the receiver. This
is an active low signal and is asserted 0 to
indicate a synchronization request or error
reporting.

Inputlink_

clk

sync_n[LINK-1:0]

Indicates amultidevice synchronization request
at the TXpath. Synchronize signal combination
should be done externally and then input to the
JESD204B IP core through this signal. In a
single link instance where multidevice
synchronization is not needed, you need to tie
this signal to the dev_sync_n signal.

Inputlink_

clk

mdev_sync_n[LINK-1:0]

Aligns all lanes for this device at the RX path.

For multidevice synchronization, multiplex all
the dev_lane_aligned signals before
connecting to this signal pin.

For single device support, connect the dev_
lane_aligned signal back to this signal.

Inputlink_

clk

alldev_lane_aligned

RX SYSREF signal for JESD204B Subclass 1
implementation.

Inputlink_

clk

rx_sysref[LINK-1:0]

JESD204B

Indicates a clean synchronization request at the
TX path. This is an active low signal and is
asserted 0 to indicate a synchronization request.
The SYNC_N signal error reporting is masked
out of this signal. This signal is also asserted
during software-initiated synchronization.

Outputlink_

clk

tx_dev_sync_n[LINK-

1:0]

Indicates that all lanes for this device are
aligned at the RX path.

Outputlink_

clk

dev_lane_aligned[LINK-

1:0]

Indicates a SYNC_N to the transmitter. This is
an active low signal and is asserted 0 to indicate
a synchronization request. Instead of reporting
the link error through this signal, the JESD204B
IP core uses the jesd204_rx_int signal to
indicate an interrupt.

Outputlink_

clk

rx_dev_sync_n[LINK-

1:0]
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DescriptionDirectionClock
Domain

SignalInterface

Output data from a slave to the input of the
master.

Inputsclkmiso

SPI

Output data from the master to the inputs of
the slaves.

Outputsclkmosi

Clock driven by the master to slaves, to
synchronize the data bits.

Outputmgmt_

clk

sclk

Active low select signal driven by the master to
individual slaves, to select the target slave.
Defaults to 3 bits.

Outputsclkss_n[2:0]

Differential high speed serial input data. The
clock is recovered from the serial data stream.

Input—rx_serial_data[LINK*L-

1:0]

Serial
Data and
Control

Differential high speed serial output data. The
clock is embedded in the serial data stream.

Outputdevice_

clk

tx_serial_data[LINK*L-

1:0]

Assert this signal to enable internal serial
loopback in the duplex transceiver.

Input—rx_

seriallpbken[LINK*L-

1:0]
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DescriptionDirectionClock
Domain

SignalInterface

Active high reconfiguration request. Set this
signal to static 0 during compile time if run
time reconfiguration is not required.

Inputmgmt_

clk

reconfig

User
Request
Control

Reconfigure the LMF value at run-time. This
value must be stable prior to assertion of the
reconfig signal.

• 0—Downscale to the LMF value stored in
MIF file.

• 1— Upscale back to maximum LMF value.

Assuming at compile time, the LMF configura-
tion is 222, set this signal to 0 to scale down the
LMF configuration to 112. Set this signal to 1
to scale up the LMF configuration back to 222.

Inputmgmt_

clk

runtime_lmf

Reconfigure the data rate at run-time. This
value must be stable prior to assertion of
reconfig signal.

• 0— Downscale to data rate setting stored in
PLL, PHY, and clock MIF.

• 1— Upscale back to maximum data rate
setting stored in PLL, PHY, and clock MIF.

Assuming the compile time data rate is 3.072
Gbps, set this signal to 0 to scale down the data
rate to 1.536 Gbps. Set this signal to 1 to scale
up the data rate back to 3.072 Gbps.

Inputmgmt_

clk

runtime_datarate

Assert high to indicate that the control unit is
busy. All reconfiguration input will be ignored
when this signal is high.

Outputmgmt_

clk

cu_busy
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DescriptionDirectionClock
Domain

SignalInterface

TX data from the Avalon-ST source interface.
The source arranges the data in a specific order,
as illustrated in the cases below:

Case 1: If F1/F2_FRAMECLK_DIV =1, LINK
= 1, M = 1, S =1, N = 16:

• avst_usr_din[15:0]

Case 2: If F1/F2_FRAMECLK_DIV =1, LINK
= 1, M = 2 (denoted by m0 and m1), S =1, N =
16:

• avst_usr_din[15:0] = m0[15:0]
• avst_usr_din[31:16] = m1[15:0]

Case 3: If F1/F2_FRAMECLK_DIV =1, LINK
= 2 (denoted by link0 and link1), M = 1, S =1,
N = 16:

• avst_usr_din[15:0] = link0
• avst_usr_din[31:16] = link1

Case 4: If F1/F2_FRAMECLK_DIV =1, LINK
= 2 (denoted by link0 and link1), M = 2
(denoted by m0 and m1), S =1, N = 16:

• avst_usr_din[15:0] = link0, m0[15:0]
• avst_usr_din[31:16] = link0, m1[15:0]
• avst_usr_din[47:32] = link1, m0[15:0]
• avst_usr_din[63:48] = link1, m1[15:0]

Inputframe_

clk

avst_usr_

din[(FRAMECLK_

DIV*LINK*M*S*N)-1:0]

Avalon-
ST User
Data

Indicates whether the data from theAvalon-ST
source interface to the transport layer is valid
or invalid.

• 0—data is invalid
• 1—data is valid

Inputframe_

clk

avst_usr_din_valid

Indicates that the transport layer is ready to
accept data from the Avalon-ST source
interface.

• 0—transport layer is not ready to receive
data

• 1—transport layer is ready to receive data

Outputframe_

clk

avst_usr_din_ready
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DescriptionDirectionClock
Domain

SignalInterface

RX data to the Avalon-ST sink interface. The
transport layer arranges the data in a specific
order, as illustrated in the cases below:

Case 1: If F1/F2_FRAMECLK_DIV =1, LINK
= 1, M = 1, S =1, N = 16:

• avst_usr_dout[15:0]

Case 2: If F1/F2_FRAMECLK_DIV =1, LINK
= 1, M = 2 (denoted by m0 and m1), S =1, N =
16:

• avst_usr_dout[15:0] = m0[15:0]
• avst_usr_dout[31:16] = m1[15:0]

Case 3: If F1/F2_FRAMECLK_DIV =1, LINK
= 2 (denoted by link0 and link1), M = 1, S =1,
N = 16:

• avst_usr_dout[15:0] = link0
• avst_usr_dout[31:16] = link1

Case 4: If F1/F2_FRAMECLK_DIV =1, LINK
= 2 (denoted by link0 and link1), M = 2
(denoted by m0 and m1), S =1, N = 16:

• avst_usr_dout[15:0] = link0, m0[15:0]
• avst_usr_dout[31:16] = link0, m1[15:0]
• avst_usr_dout[47:32] = link1, m0[15:0]
• avst_usr_dout[63:48] = link1, m1[15:0]

Outputframe_

clk

avst_usr_

dout[(FRAMECLK_

DIV*LINK*M*S*N)-1:0]

Avalon-
ST User
Data

Indicates whether the data from the transport
layer to the Avalon-ST sink interface is valid or
invalid.

• 0—data is invalid
• 1—data is valid

Outputframe_

clk

avst_usr_dout_valid

Indicates that the Avalon-ST sink interface is
ready to accept data from the transport layer.

• 0—Avalon-ST sink interface is not ready to
receive data

• 1—Avalon-ST sink interface is ready to
receive data

Inputframe_

clk

avst_usr_dout_ready
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DescriptionDirectionClock
Domain

SignalInterface

Specifies the operation mode.

• 0000—Normal mode. The design example
takes data from the Avalon-ST source.

• 1000—Test mode. The design example
generates alternate checkerboard data
pattern.

• 1001—Test mode. The design example
generates ramp wave data pattern.

• 1010—Test mode. The design example
generates the PRBS data pattern.

• Others—Reserved

Inputframe_

clk

test_mode[3:0]Avalon-
ST User
Data

Asserted to indicate that the RX CDR PLL is
locked to the RX data and the RX CDR has
changed from LTR to LTD mode.

Outputdevice_

clk

rx_is_lockedtodata

[LINK*L-1:0]

Status

Asserted to indicate that the pattern checker
has found a mismatch in the received data and
the expected data. One error signal per pattern
checker.

Outputframe_

clk

data_error [LINK-1:0]

Interrupt pin for the JESD204B IP core (TX).
The interrupt signal is asserted when an error
condition or synchronization request is
detected.

Outputlink_

clk

jesd204_tx_int[LINK-

1:0]

Interrupt pin for the JESD204B IP core (RX).
The interrupt signal is asserted when an error
condition or synchronization request is
detected.

Outputlink_

clk

jesd204_rx_int[LINK-

1:0]

Example Feature: Dynamic Reconfiguration
The JESD204B IP core design example demonstrates dynamic (run-time) reconfiguration of either the LMF
or data rate at any one time.

Dynamic Reconfiguration Operation

The dynamic reconfiguration feature implements an architecture which consists of various reconfiguration
controllermodules (PLL reconfiguration, Transceiver ReconfigurationController, SPImaster, and JESD204B
IP core Avalon-MM slave). These modules connect to the control unit through the Avalon-MM interface.
You can control the reconfiguration using the reconfig, runtime_lmf, and runtime_datarate input ports
exposed at control unit interface.
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Figure 5-19: Dynamic Reconfiguration Block Diagram (For 28 nm Device Families—Stratix V and Arria V)
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Figure 5-20: Dynamic Reconfiguration Block Diagram (For 20 nm Device Families—Arria 10)
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MIF ROM content for maximum and downscale configuration:

• PLL MIF ROM—contains the PLL counter, charge pump, and bandwidth setting.
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• JESD MIF ROM—contains the LMF information.
• PHY MIF ROM—contains the transceiver channel and PLL setting.
• ADC MIF ROM—contains the ADC converter setting.
• DAC MIF ROM—contains the DAC converter setting.
• CLK MIF ROM—contains the device clock setting.

MIF ROM

You need to generate two MIF files for each reconfigurable IP core as shown in Figure 5-19 or Figure 5-20,
and merge them into a single MIF file for each IP core. The following section shows the MIF file format.

Core PLL

The MIF format is fixed by the PLL. You need to generate two PLLs with maximum and downscale setting
to get these two MIF files. Then, merge the files into one (core_pll.mif). Only the PLL with maximum
configuration is used in final compilation.

Maximum Configuration MIF
WIDTH=32;
DEPTH=92;

ADDRESS_RADIX=UNS;
DATA_RADIX=BIN;

CONTENT BEGIN
 0   :   00000000000000000000000000111110; -- START OF MIF
 1   :   00000000000000000000000000000100;
 2   :   00000000000000000000000100000001;
 3   :   00000000000000000000000000000011;
.
.
.
 42  :   00000000000000000000000000000010;
 43  :   00000000000000000000000000001000;
 44  :   00000000000000000000000001000000;
 45  :   00000000000000000000000000111111; -- END OF MIF

Downscale Configuration MIF

 46  :   00000000000000000000000000111110; -- START OF MIF
 47  :   00000000000000000000000000000100;
 48  :   00000000000000000000000100000001;
 49  :   00000000000000000000000000000011;
.
.
.
 88  :   00000000000000000000000000000010;
 89  :   00000000000000000000000000001000;
 90  :   00000000000000000000000001000000;
 91  :   00000000000000000000000000111111; -- END OF MIF
END;

PHY (Stratix V and Arria V)

The MIF format is fixed by the PHY. You need to generate two JESD204B IP cores with maximum and
downscale setting. Then, compile each of the setting to get a total of four MIF files (two for TX PLL and two
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for channel MIF). Then, merge the files into one (phy.mif). Only the JESD204B IP cores with maximum
configuration is used in final compilation.

Maximum TX PLL Configuration MIF
WIDTH=16;
DEPTH=186;

ADDRESS_RADIX=UNS;
DATA_RADIX=BIN;

CONTENT BEGIN
 0    :   0000000000100001; -- Start of MIF opcode (TX_PLL, 6144Mbps)
 1    :   0000000000100010;
.
.
.
 10   :   0011000000000000;
 11   :   0000000000011111; -- End of MIF opcode

Maximum Channel Configuration MIF

 12   :   0000000000100001; -- Start of MIF opcode (Channel, 6144Mbps)
 13   :   0000000000000010;
.
.
.
 [88..91]  :   0000000000000000;
 92   :   0000000000011111; -- End of MIF opcode

Downscale TX PLL Configuration MIF

 93   :   0000000000100001; -- Start of MIF opcode (TX_PLL, 3072Mbps)
 94   :   0000000000100010;
.
.
.
 103  :   0011000000000000;
 104  :   0000000000011111; -- End of MIF opcode

Downscale Channel Configuration MIF

 105  :   0000000000100001; -- Start of MIF opcode (Channel, 3072Mbps)
 106  :   0000000000000010;
.
.
.
 [181..184]  :   0000000000000000;
 185  :   0000000000011111; -- End of MIF opcode
END;

PHY (Arria 10)

The MIF format is fixed by the PHY. You need to generate two JESD204B IP cores with maximum and
downscale setting. Then, compile each of the setting to get a total of four MIF files (two for TX PLL and two
for channel MIF). Then, merge the files into two (xcvr_atx_pll_combined.mif and xcvr_cdr_combined.mif).
Only the JESD204B IP cores with maximum configuration is used in final compilation.

xcvr_atx_pll_combined.mif

Maximum Configuration MIF
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CONTENT BEGIN
 00    :   102FF71; -- Start of MIF
 01    :   103BF01;
 02    :   1047F04;
 03    :   1054700;
.
.
.
 10   :   11AFF00;
 11   :   11CE020;
 12   :   11DE020;
 13   :   3FFFFFF; -- End of MIF

Downscale Channel Configuration MIF

 14    :   102FF71; -- Start of MIF
 15    :   103BF01;
 16    :   1047F04;
 17    :   1054700;
.
.
.
 24   :   11AFF00;
 25   :   11CE020;
 26   :   11DE020;
 27   :   3FFFFFF; -- End of MIF
END;

xcvr_cdr_combined.mif

Maximum Configuration MIF

CONTENT BEGIN
 00    :   006DF02; -- Start of MIF
 01    :   007FF09;
 02    :   008FF04;
 03    :   00AFF01;
.
.
.
 76   :   173FF31;
 77   :   1741F0C;
 78   :   1753F13;
 79   :   3FFFFFF; -- End of MIF

Downscale Channel Configuration MIF

 7A    :   006DF02; -- Start of MIF
 7B    :   007FF09;
 7C    :   008FF04;
 7D    :   00AFF01;
.
.
.
 F0   :   173FF31;
 F1   :   1741F0C;
 F2   :   1753F13;
 F3   :   3FFFFFF; -- End of MIF
END;
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JESD

The current JESD MIF contains only the LMF information. You need to manually code the MIF content in
the following format.

Maximum Configuration MIF
WIDTH=16;
DEPTH=16;

ADDRESS_RADIX=UNS;
DATA_RADIX=BIN;

CONTENT BEGIN
 0    :   0000000000000001; -- L            (maximum config)
 1    :   0000000000000001; -- M
 2    :   0000000000000001; -- F
.
.
.
 3    :   1111111111111111; -- End of MIF
 [4..7]  :   0000000000000000; 

Downscale Configuration MIF

 8    :   0000000000000000; -- L            (downscale config)
 9    :   0000000000000000; -- M
 10   :   0000000000000001; -- F
.
.
.
 11   :   1111111111111111; -- End of MIF
 [12..15]  :   0000000000000000; 
END;

ADC/DAC/CLK

The content for ADC/DAC/CLK MIF is vendor-specific. The general format for the MIF is as shown below,
with each section terminated by all 1's.

Maximum Configuration MIF
WIDTH=32;
DEPTH=128;

ADDRESS_RADIX=UNS;
DATA_RADIX=BIN;

CONTENT BEGIN
 0   :   10000100000000000001000001111100;  -- (Maximum Config)
 1   :   10000100000000000001010000000101;  
 2   :   10000100000000000001011000000101;  
 3   :   10000100000000000001110000000010;  
.
.
.
 28  :   10000001000000001111111100000001;  
 29  :   10000001000000000101111100010100;  
 30  :   11111111111111111111111111111111;  -- End of MIF
 [31..63] :   00000000000000000000000000000000;

Downscale Configuration MIF

 64  :   10000100000000000001000001111100;   -- (downscale config)
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 65  :   10000100000000000001010000000101;
 66  :   10000100000000000001011000000101;
 67  :   10000100000000000001110000000010;
.
.
.
 92  :   10000001000000001111111100000001; 
 93  :   10000001000000000101111100010100;
 94  :   11111111111111111111111111111111;  -- End of MIF
 95..127]  :   00000000000000000000000000000000;
END;

Generating and Simulating the Design Example
To use the JESD204B IP core design example testbench, follow these steps:

1. Generate the design example simulation testbench. Refer toGenerating theDesignExample Simulation
Model on page 5-52

2. Simulate the design example using simulator-specific scripts. Refer to Simulating the JESD204B IPCore
Design Example on page 5-52

Generating the Design Example Simulation Model

After generating the IP core, generate the design example simulation testbench using the script
(gen_ed_sim_verilog.tcl or gen_ed_sim_vhdl) located in the <example_design_directory>/ed_sim directory.

For more information about the JESD204B design example testbench, refer to the README_DESIGN_
EXAMPLE.txt file located in the <example_design_directory>/ed_sim folder.

Note:

To run the Tcl script using the Quartus II sofware, follow these steps:

1. Launch the Quartus II software.
2. On the View menu, click Utilities and select Tcl console.
3. In the Tcl console, type cd <example_design_directory>/ed_sim to go to the specified

directory.
4. Type source gen_ed_sim_verilog.tcl (Verilog) or source gen_ed_sim_vhdl.tcl

(VHDL) to generate the simulation files.

To run the Tcl script using the command line, follow these steps:

1. Obtain the Quartus II software resource.
2. Type cd <example_design_directory>/ed_sim to go to the specified directory.
3. Type quartus_sh -t gen_ed_sim_verilog.tcl (Verilog) or quartus_sh -t

gen_ed_sim_vhdl.tcl (VHDL) to generate the simulation files.

Simulating the JESD204B IP Core Design Example

By default, the Quartus II software generates simulator-specific scripts containing commands to compile,
elaborate, and simulate Altera IP models and simulation model library files. You can copy the commands
into your simulation testbench script, or edit these files to add commands for compiling, elaborating, and
simulating your design and testbench.
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To simulate the design using the ModelSim-Altera SE/AE simulator, follow these steps:

1. Start the ModelSim-Altera simulator.
2. On the File menu, click Change Directory > Select

<example_design_directory>/ed_sim/testbench/mentor.
3. On the File menu, click Load >Macro file. Select run_tb_top.tcl. This file compiles the design and runs

the simulation automatically, providing a pass/fail indication on completion.

To simulate the design using the VCS MX simulator (in Linux), follow these steps:

1. Start the VCS MX simulator.
2. On the File menu, click Change Directory > Select

<example_design_directory>/ed_sim/testbench/synopsys/vcsmx.
3. Run run_tb_top.sh. This file compiles the design and runs the simulation automatically, providing a

pass/fail indication on completion.

To simulate the design using the Aldec Riviera-PRO simulator, follow these steps:

1. Start the Aldec Riviera-PRO simulator.
2. On the Filemenu, clickChangeDirectory > Select<example_design_directory>/ed_sim/testbench/aldec.
3. On the Tools menu, click Execute Macro. Select run_tb_top.tcl. This file compiles the design and runs

the simulation automatically, providing a pass/fail indication on completion.

Compiling the JESD204B IP Core Design Example
You can use the generated .qip file to include relevant files into your project. Generate theQuartus II synthesis
compilation files by running the script (gen_quartus_synth.tcl) located in the <example_design_directory>/
ed_synth/ directory.

If you use the Quartus II Tcl console to generate the gen_quartus_synth.tcl script, close all Quartus
II project before you start generating.

Note:

To compile your design using the Quartus II software , follow these steps:

1. Launch the Quartus II software.
2. On the File menu, click Open Project > Select <example_design_directory>/ed_synth/example_design/.
3. Select jesd204b_ed.qpf. (32)

4. On the Processing menu, click Start Compilation.

At the end of the compilation, the Quartus II software provides a pass/fail indication.

(32) This is the default quartus project file that the Quartus II software automatically generates. You can edit this
file and the .qsf file according to your design preference.
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This section lists some guidelines to assist you in debugging JESD204B link issues. Apart from applying
general board level hardware troubleshooting technique like checking the power supply, external clock
source, physical damage on components, a fundamental understanding of the JESD204B subsystemoperation
is important.

Related Information

• Clocking Scheme on page 6-1

• JESD204B Parameters on page 6-1

• SPI Programming on page 6-2

• Converter and FPGA Operating Conditions on page 6-2

• Signal Polarity and FPGA Pin Assignment on page 6-2

• Debugging JESD204B Link Using SignalTap II and System Console on page 6-3

Clocking Scheme

To verifying the clocking scheme, follow these steps:

1. Check that the frame and link clock frequency settings are correct in the Altera PLL IP core. For the
design example, the frame clock is assigned to outclk0 and link clock is assigned to outclk1.

2. Check the device clock frequency at the FPGA and converter.
3. For Subclass 1, check the SYSREF pulse frequency.
4. Check the clock frequency management. For the design example, using Stratix V and Arria V devices,

this frequency is 100 MHz.

JESD204B Parameters

The parameters in both the FPGA and ADC should be set to the same values. For example, when you set K
= 32 on the FPGA, set the converter's K value to 32 as well. Scrambling does not affect the link initialization
in the CGS and ILAS phases but in the user data phase. When scrambling is enabled on the ADC, the FPGA
descrambling option has to be turned on using the "Enable scramble (SCR)" option in the JESD204B IP core
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Qsys parameter editor. When scrambling is enabled on the FPGA, the DAC descrambling has to be turned
on too.

Check these items:

• Turn off the scrambler and descrambler options as needed.
• Use single lane configuration and K = 32 value to isolate multiple lane alignment issue.
• Use Subclass 0 mode to isolate SYSREF related issues like setup or hold time and frequency of SYSREF

pulse.

SPI Programming

The SPI interface configures the converter. Hence, it is important to check the SPI programming sequence
and register bit settings for the converter. If you are using MIF to store the SPI register settings of the
converter, common mistakes can be made when modifying the MIF, for example, mistakenly setting certain
bit to "1" instead of "0", missing or extra bits in a MIF content row.

Check these items:

• For the ADI converter, you are recommended to perform register bit setting first for the scramble (SCR)
or lane (L) register at address 0x6E before setting the quick configuration register at address 0x5E.

• Determine that each row of the MIF has the same number of bits as the data width of the ROM that stores
the MIF.

Converter and FPGA Operating Conditions

The transceiver channels at the converter and FPGA are bounded by minimum and maximum data rate
requirements. Always check the most updated device data sheet for this info. For example, the Arria V GT
device has a minimum data rate of 611 Mbps.

Ensure that the sampling rate of the converter is within the minimum and maximum requirements. For
example, the ADC AD9250 has a minimum sampling rate of 40 Msps. For L = 2, M = 1 configuration, the
minimum data rate of this ADC is calculated this way:

The minimum data rate for the JESD204B link is effectively 611 Mbps.

Check these items:

• Reduce the data rate or sampling clock frequency if your targeted operating requirement does not work.
• Verify the minimum and maximum data rate requirements in the device manufacturer's data sheet.

Signal Polarity and FPGA Pin Assignment
Verify that the transceiver channel pin assignments—SYNC_N and SYSREF (for Subclass 1 only)—device
clock, and SPI interface are correct. Also verify the signal polarity of the differential pairs like SYNC_N and
transceiver channels are correct.
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Check these items:

• Review the schematic and board layout file to determine the polarity of the physical pin connection.
• Use assignment editor and pin planner to check the pin assignment and I/O standard for each pin.
• Use RTL viewer in the Quartus II software to verify that the top level port are connected to the lower

level module that you instantiate.

Debugging JESD204B Link Using SignalTap II and System Console
The SignalTap II provides dynamic view of signals while the system console provides access to the JESD204B
IP core register sets through the Avalon-MM interfaces.

The SignalTap II and system console are very useful tools in debugging the JESD204B link related issues.
To use the system console, your design must contain a Qsys subsystem with the JTAG-to-Avalon-MM
Master bridge component and theMerlin slave translator ports that connect to the JESD204B IP coreAvalon-
MM interface.

PHY Layer

Verify the RX PHY status through these signals in the <ip_variant_name>.v:

• rx_is_lockedtodata
• rx_analogreset
• rx_digitalreset
• rx_cal_busy

Verify the TX PHY status through these signals in the <ip_variant_name>.v:

• pll_locked
• pll_powerdown
• tx_analogreset
• tx_digitalreset
• tx_cal_busy

Verify the RX_TX PHY status through these signals in the <ip_variant_name>.v:

• rx_is_lockedtodata
• rx_analogreset
• rx_digitalreset
• rx_cal_busy
• rx_seriallpbken
• pll_locked
• pll_powerdown
• tx_analogreset
• tx_digitalreset
• tx_cal_busy

Use the rxphy_clk[0] or txphy_clk[0] signal as sampling clock for the SignalTap II.

For a normal operation of the JESD204B RX path, the rx_is_lockedtodata bit for each lane should be "1"
while the rx_cal_busy, rx_analogreset, and rx_digitalreset bit for each lane should be "0".

For a normal operation of the JESD204B TX path, the pll_locked bit for each lane should be "1" while the
tx_cal_busy, pll_powerdown, tx_analogreset, and tx_digitalreset bit for each lane should be "0".
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Measure the rxphy_clk or txphy_clk frequency by connecting the clock to the CLKOUT pin on the FPGA.
The frequency should be the same as link clock frequency.

Link Layer

Verify theRXPHY-link layer interface operation through these signals in the<ip_variant_name>_inst_phy.v:

• jesd204_rx_pcs_data
• jesd204_rx_pcs_data_valid
• jesd204_rx_pcs_kchar_data
• jesd204_rx_pcs_errdetect
• jesd204_rx_pcs_disperr

Verify the RX link layer and RX PHY-link layer interface operation through these signals in the
<ip_variant_name>_inst_phy.v:

• rx_dev_sync_n
• jesd204_rx_int
• dev_lane_aligned
• rx_somf

Use the rxlink_clk signal as sampling clock.

To debug the TX path when interfacing with a DAC, verify the JESD204B functionality by accessing the
DAC SPI registers or any debug feature provided by the DAC manufacturer.
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Figure 6-1: JESD204B Link Initialization

This is a SignalTap II image during the JESD204B link initialization. The JESD204B link has two transceiver
channels (L = 2).
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start of 1st ILAS multi-frame

Description:

a. The JESD204B link is out of reset.
b. The RX CDR is locked and PCS outputs valid characters to link layer.
c. No running disparity error and 8b/10b blockwithin PCS successfully decodes the incoming characters.
d. The ADC transmits /K/ character or BC hexadecimal number to the FPGA, which starts the CGS
phase.
e. Upon receiving 4 consecutive /K/ characters, the link layer deasserts the rx_dev_sync_n signal.
f. The JESD204B link transition from CGS to ILAS phase when ADC transmit /R/ or 1C hexadecimal
after /K/ character.
g. Start of 2nd multi-frame in ILAS phase. 2nd multi-frame contains the JESD204B link configuration
data.
h. Start of 3rd multi-frame.
i. Start of 4th multi-frame.
j. Device lanes alignment is achieved. In this example, there is only one device, the dev_lane_aligned
connects to alldev_lane_aligned and both signals are asserted together.
k. Start of user data phase where user data is streamed through the JESD204B link
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Transport Layer

Verify the transport layer operation using these signals in the altera_jesd204_transport_rx_top.sv:

• jesd204_rx_dataout
• jesd204_rx_data_valid
• jesd204_rx_data_ready
• jesd204_rx_link_data_ready
• jesd204_rx_link_error

For normal operation, the jesd204_rx_data_valid, jesd204_rx_data_ready, and
jesd204_rx_link_data_ready signals should be asserted while the jesd204_rx_link_error should be
deasserted. You can view the ramp or sine wave test pattern on the jesd204_rx_dataout signal.

Figure 6-2: Ramp Pattern on the jesd204_rx_dataout Signal

This is a SignalTap II image during the JESD204B user data phase with ramp pattern transmitted from the
ADC.

Related Information

• AN 696: Using the JESD204B MegaCore Function in Arria V Devices
More information about the performance and interoperability of the JESD204B IP core.

• Altera Transceiver PHY IP Core User Guide
More information about the transceiver PHY signals.
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Additional information about the document and Altera.

Document Revision History

ChangesVersionDate

• Updated Figure 2-1 to show a typical system application.
• Updated the list of core key features.
• Updated the Performance and Resource utilization values.
• Updated the Getting Started chapter to reflect the new IP Catalog and

parameter editor.
• Added the following new sections to further describe the JESD204B IP

core features:

• Operating Modes
• Datapath Modes
• IP Core Variation
• JESD204B IP Core Testbench
• JESD204B IP Core Design Considerations
• TX Data Link Layer
• TX PHY Layer
• RX Data Link Layer
• RX PHY Layer
• JESD204B IP Core Operation
• Dynamic Reconfiguration
• JESD204B IP Core Debug Guidelines

• Updated the Clocking scheme section.
• Added new transceiver signals to that is supported in Arria 10 devices.
• Updated the Transport Layer section.
• Added run-time reconfiguration parameter values in the System

Parameters section.
• Updated the file directory names.
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How to Contact Altera

Table 7-1: Altera Contact Information

AddressContact MethodContact(33)

www.altera.com/supportWebsiteTechnical support

www.altera.com/trainingWebsite
Technical training

custrain@altera.comEmail

www.altera.com/literatureWebsiteProduct literature

nacomp@altera.comEmailGeneral
Nontechnical support

apgcs@altera.comEmailSoftware licensing

Related Information

• www.altera.com/support

• www.altera.com/training

• www.altera.com/literature

(33) You can also contact your local Altera sales office or sales representative.
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